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Introduction to Bria Enterprise

(missing or bad snippet)

This user guide is intended for end users in an enterprise or subscribers of a service
provider who has deployed Bria Enterprise.

Bria Enterprise Features

Standard enterprise telephone features
l Call display
l Voicemail with message waiting indicator (MWI)
l Speakerphone and mute
l Redial
l Hold
l Do not disturb
l Call history
l Call forward
l Call transfer
l Call record
l Auto answer
l Six-party audio conferencing (hosted locally)
l Five-party video conferencing (hosted locally)
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Advanced features and functions
l Video calls with 1080p HD support
l IM and presence
l IM sync and call history sync
l Corporate chat rooms
l Text messaging (SMS)
l Contact list containing the individual user’s contacts
l Favorites list
l Directory containing names from a shared LDAP directory
l Windows only: Directory containing names from a shared Microsoft® Active
Directory®

l Windows only: Access to Microsoft Outlook® contacts from within Bria Enterprise
l Mac only: Access to Mac address book contacts from within Bria Enterprise
l Windows only: Microsoft Outlook integration
l File transfer
l Screen share
l Support for DTMF (RFC 2833, SIP INFO or inband DTMF)
l Automatic detection of audio and video devices
l Acoustic echo cancellation, automatic gain control, voice activity detection
l Audio codecs: G.711aLaw, G.711µLaw, G.722, G.729A, G.729B, GSM, Opus,
SILK Narrowband, SILK Wideband, SILK Super-Wideband, Speex Narrowband,
Speex Wideband, Speex Wideband

l Video codecs: H.264, VP8
l Support for these firewall traversal solutions: STUN, TURN, or ICE
l Support for the following languages in addition to English: Chinese (Simplified and
Traditional), Dutch, French, German, Italian, Korean, Japanese, Polish, Portuguese
(Brazil), Russian, and Spanish
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Requirements

Service requirements
l A VoIP service subscription with a local service provider or ISP in order to make
audio or video calls with Bria Enterprise. Please contact your local service provider
to subscribe.

l An XMPP service subscription for presence and messaging.
l A subscription to Bria Enterprise

System requirements

Component Requirement

Processor Minimum: Single-core 2GHz or higher

Recommended: Dual-core 2GHz or higher

Memory Minimum: 4GB RAM

Recommended: 8 GB RAM and above

Hard Disk Space 400 MB (Install/Upgrade, 200 MB operation)

Operating System Microsoft Windows 10 (Fall Creators Update or newer required)

Microsoft Windows 11

Microsoft .Net 4.8

macOS 11 (Big Sur)

macOS 12 (Monterey)

Connection IP network connection (broadband, LAN, wireless); Constant Internet connection

Audio Device Full duplex, 16-bit or USB headset

Desktop System Requirements
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Getting started

Bria Enterprise is deployed using a configuration server. If you are deploying Bria
Enterprise with the help of a system administrator, follow the instructions given by the
administrator.

Launching Bria Enterprise
To launch Bria Enterprise

1. Obtain the Bria Enterprise download file and follow the prompts in the install wizard.

2. Start Bria Enterprise as you would any other program. The Bria Enterprise Login
dialog appears.

3. Enter your login credentials as provided by your system administrator and click
Sign in.

The softphone interface opens.
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OnWindows, your computer must have the root certificate installed in order to
access the Stretto server from the client. Normally this certificate downloads
automatically. If this fails to happen, you can manually force Windows to download
the certificate.

Open Internet Explorer and go to https://ccs3.cloudprovisioning.com/status. This will
prompt Windows to download the correct root certificate. Make sure to use Internet
Explorer. Using a different browser will not work.

Giving permissions to Bria Enterprise (Mac)
When using Bria Enterprise with macOS Mojave or higher, Bria Enterprise needs some of
these permissions in order to access certain functions. Bria Enterprise asks permissions
for:

l Notifications: For incoming calls and messages.
See Configuring OS notifications to set up the type of notification.

l Contacts: For displaying your contact list within Bria Enterprise.
l Microphone: For phone conversations.
l Camera: For video calls.
l Screen recording: For screen sharing. Required for macOS 10.15 Catalina.

Allow Bria Enterprise a permission if a pop-up appears.

If you have recently updated to Mojave from a previous macOS version, or you find that
you do not have outgoing audio or video during calls, or you have issues integrating your
Mac Address Book contacts, you may need to update the permissions in System
Preferences.

To give macOS permissions to Bria Enterprise

1. Click to open the Apple menu and select System Preferences.

2. Click Security & Privacy and select the Privacy tab.

3. Find the Contacts category. Select Bria Enterprise to allow access.
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4. Find the Camera category. Select Bria Enterprise to allow access.

5. Find the Microphone category. Select Bria Enterprise to allow access.

6. Find the Screen Recording category. Select Bria Enterprise to allow access.
Required for macOS 10.15 Catalina.

Bria Enterprise's permissions are updated.

Minimizing Bria Enterprise
If you click Minimize to system tray (Windows) or the red close button (Mac), Bria
Enterprise does not actually exit, it is simply minimized to the system tray (Windows) or
the dock (Mac) but continues running in the back ground.

To open Bria Enterprise from the system tray (Windows)

1. Open the Windows system tray.

2. Right-click on Bria Enterprise and select Show the Phone.

Bria Enterprise opens the phone on the desktop.

Exiting Bria Enterprise
When you are ready to stop using Bria Enterprise, you need to exit Bria Enterprise. If you
simply close the Bria Enterprise on screen phone, Bria Enterprise continues to run in the
background.

To exit using the menu

1. Click Exit of the Softphone menu (Windows) or click Quit Bria Enterprise on the
menu bar (Mac).

Bria Enterprise stops running and the application closes.

To exit using keyboard accelerators

1. Bring Bria Enterprise into focus.

2. Type CTRL+Q (Windows) or COMMAND+Q (Mac).

Bria Enterprise stops running and the application closes.
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To exit from the taskbar (Windows)

1. Right-click on Bria Enterprise in the taskbar.

2. Click Exit.

Bria Enterprise stops running and the application closes.

To exit from the dock (Mac)

1. CONTROL+Click on Bria Enterprise in the dock.

2. Click Quit.

Bria Enterprise stops running and the application closes.
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To exit from the system tray (Window)

1. Open the Windows system tray.

2. Right-click on Bria Enterprise and select Exit.

Bria Enterprise stops running and the application closes.

Setting up accounts
Bria Enterprise supports SIP accounts, XMPP accounts, Windows Outlook accounts, G-
Suite account, and Mac Address Book accounts.

Account type
A SIP account is used to make voice and video calls in Bria Enterprise. Each user
requires at least one SIP account. The SIP account can also be used for presence and
messaging if your VoIP service provide supports SIP SIMPLE.

An XMPP account can be used for presence and messaging. An XMPP account is not
required.

A G-suite account can be used to provide Bria Enterprise with access to the contacts in
your account.

On Windows, an Outlook account can be used to provide Bria Enterprise with access to
the contacts in your address book. A Windows Outlook account is not required.

On Mac, your Mac Address Book account is used to import your contacts into Bria
Enterprise. The Mac Address Book account is automatically created in Bria Enterprise.

Your system administrator sets up your SIP and XMPP accounts. All fields in Softphone
> Account Settings (Windows) and Bria Enterprise > Preferences > Account Settings
(Mac) are read-only.

Using the Bria Enterprise interface
You can navigate in Bria Enterprise using the icons on the resource panel and the Bria
Enterprise menu.
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You can rearrange the order of the icons on the resource panel by dragging and dropping
them into your preferred order.

Windows

The Windows on-screen phone

Compact view
To create the compact view, hide all the resources using the View menu.
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Bria Enterprise menus
The Softphone, View, Contacts, and Help menus are available in the Bria Enterprise
menu.

Softphone menu

l Account settings: Account settings apply to individual accounts. These settings
control how you interact with your VoIP service provider. See Account settings for
more information.

l Preferences: Preferences apply to all accounts. These settings control the way you
work with Bria Enterprise. See Preferences for more information.

l Sign out: Sign out logs you out of Bria Enterprise and Bria Enterprise displays the
log in screen. This menu item only shows when you select Softphone >
Preferences – Application > Enable Sign In.

l Exit: Use Exit to shut down Bria Enterprise. You can also use CTRL+Q.

View menu

Use the View menu to change how Bria Enterprise looks. In the View menu, you can
show or hide which resources are on the resource panel, open the Messages windows,
and view your Video.

Contacts menu

Use the Contacts menu to add contacts and groups, and to change the way your
contacts are displayed in Contacts and Favorites.

Help menu

The Help menu provides support for Bria Enterprise. Use the Help menu to access
CounterPath Technical Support, access the online user guide, troubleshoot problems,
and check for updates.
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Detaching tabs
The Contacts, Favorites, History, and the Directory panels can all be detached from the
on-screen phone into their own window. On the resource panel, click on the tab you want
to detach and then click Detach window. To return the window to the on-screen phone,
click Move back to main window.

Mac

The Mac on-screen phone
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Compact view

To create the compact view, hide all resources on the View menu.

Bria Enterprise menus

The Bria Enterprise menu

The Bria Enterprise menu allows you to set up your accounts and preferences, change
the look of the Bria Enterprise interface, work with contacts, and find support for Bria
Enterprise.

l Preferences: Preferences apply to all accounts. These settings control the way you
work with Bria Enterprise.

l Accounts Settings: Account settings are found in the Preferences menu. Account
settings apply to individual accounts. These settings control how you interact with
your VoIP service provider.

l Quit: Use Quit to shut down Bria Enterprise. You can also use COMMAND+Q.

View menu

Use the View menu to change how Bria Enterprise looks. In the View menu, you can
show or hide which resources are on the resource panel.

Windows menu

Use the Windows menu to Show Messages, Show Video, and Show Chat Rooms.
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Contacts menu

Use the Contacts menu to add contacts and groups, and to change the way your
contacts are displayed in Contacts and Favorites.

Help menu

The Help menu provides support for Bria Enterprise. Use the Help menu to access
CounterPath Support Center, access the online user guide, troubleshoot problems, and
check for updates.

If you have Collaboration enabled, Start or schedule a conference appears on
the on-screen phone. See the Bria Enterprise Collaboration User Guide for
information on using Collaboration.

Configuring OS notifications
Bria Enterprise uses OS notifications. This section describes how to set these
notifications.

When you have configured the OS notifications, make sure that the notifications are also
set up in Preferences: Alerts and sounds panel.

For information on the device that Bria Enterprise uses for ringing, incoming audio, and
incoming video, see Preferences: Devices panel.
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To set up notifications on Windows 10

1. From the Start menu, select Settings > System. > Notifications & actions.

2. Under Get notifications from these senders, click the entry for Bria Enterprise.

3. Choose the notification style and preferences.

To set up notifications on a Mac

You can choose banner or alert style notifications. Banner style notifications appear
briefly in the top corner of the screen. Alert styles notifications appear and remain on the
screen until you take action on them.

1. Click the Apple icon on the Bria Enterprise menu and click System Preferences.

2. Click Notifications.

3. Click Bria Enterprise.

4. Choose Banners or Alerts for the alert style.

5. Update any other notification settings.

You will receive either a banner or alert notification when you have an incoming call or
instant message on Bria Enterprise.

Managing your devices
Your subscription determines how many devices you can use Bria Enterprise at the same
time.

You might be able to manage your devices using Bria Enterprise if End User Portal has
been setup by your administrator.

In Bria Enterprise menu, click View > Show User Portal. The User Portal appears in Bria
Enterprise. Click Devices and delete a device you are no longer using.

If you do not see Show User Portal, contact your administrator who can delete the old
device for you.
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Checking for Bria Enterprise software updates
If you are in an enterprise, your system administrator should tell you about the policy for
checking for and installing updates.

To see if an update is available

1. Click Check for Updates on the Help menu.

The Auto Update (Windows) or the Auto Upgrade (Mac) window opens.

If a new version of the software is available, you can download it from this window. If no
newer version is available, this window informs you that your version is up to date.
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Calls

You can use Bria Enterprise to place and receive audio and video calls, as well as host
conference calls. You can forward, transfer, and record calls.

A user must have at least one SIP account registered in order to place and receive calls.

In addition to a SIP account, a speaker and a microphone are necessary for audio calls.
For video calls, you also require a video camera to allow the remote parties to see your
image. Bria Enterprise works with most USB video cameras.

You can test your devices in Softphone > Preferences > Devices (Windows) or Bria
Enterprise > Preferences > Devices (Mac).

Tip:
Pausing music when making or receiving calls

For Mac users:

The Bria Enterprise for Mac app has a preference for pausing Apple Music. It does
not stop anything else such as Spotify or YouTube; you will have to pause it
manually.

For Windows users:

Windows offers a feature called "Default Communication Device" where users can
choose whether to stop music or reduce volume when Windows detects
communication activities such as making and receiving calls.

To use this feature, you need to configure both Windows and Bria Enterprise.

1. Set your headsets to be Default Communication Device on Windows. Right-
click on the Speaker icon in Windows taskbar, then click Sounds, and click the
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Playback tab. Select the headsets you want to use for phone calls and right-
click to show the menu and choose Set as Default Communication Device.
Click Apply.

2. In Bria Enterprise app, go to Softphone > Preferences > Devices, then choose
Default Communication Device as your headsets.

To change the behavior when Windows detects communication activities:

1. Right-click on the Speaker icon in Windows taskbar, then click Sounds.

2. Click the Communications tab and select an option for muting or reducing
volume.

3. Click Apply.

Placing an audio or video call
Place audio and video calls in Bria Enterprise from the dialer, Contacts, Favorites,
Directory (if available), History, or Messages.
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Bria Enterprise has default actions for the call button and for double-clicking a contact.
Set the default actions in the Preferences > Application: Default Actions.

Using the dialer
Enter a name or phone number in Bria Enterprise's dialer to make a voice or video call
from any tab on the resource panel.

To place a call using auto-complete

1. Type the name, phone number, jid, or email of the person you want to call in the
Enter name or number field. As you type, Bria Enterprise may display suggestions
for completing the entry.

2. Press ENTER after typing the full name, phone number, jid, or email or use the up
and down arrow keys on your keyboard to move through the list of suggestions and
press ENTER or TAB to dial.

Bria Enterprise makes the call.

To place a call using Make a call or Make a video call

1. Click Make a call or Make a video call after typing the full name, phone
number, jid, or email.

2. Do one of the following:

Bria Enterprise makes the call.
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To place a call using the More menu

1. Select Audio Call or Video Call from the More call options menu after typing the
full name, phone number, jid, or email.

Bria Enterprise makes the call.

Using redial
Redial a number by clicking Make a call or Make a video call or by using the List of
recent calls.

To redial using Make a call or Make a video call

1. Tap Make a call or Make a video call beside Enter name or number.

The last number dialed appears.

2. Tap Make a call or Make a video call a second time.

Bria Enterprise makes the call.
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To redial using the More menu

1. Tap Make a call or Make a video call beside Enter name or number.

The last number dialed appears.

2. Select Audio Call or Video Call from the More call options menu.

Bria Enterprise makes the call.

To redial using the List of recent calls

Bria Enterprise places an audio call when you use the drop-down list even if the call was
a video call.

1. Tap the List of recent calls drop-down arrow in the Enter name or number field. A
list of recent calls appears.

2. Click the number or person you want to call.

Bria Enterprise places the audio call.
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Using Contacts, Favorites, or Directory
Make calls on Bria Enterprise using the click-to-call button, single-click, double-click, or
the shortcut menu in Contacts, Favorites, or Directory (if available).

To place a call using the click-to-call button

1. Type a name in Search Contacts, Search Favorites, or Search Directory or scroll
through Contacts, Favorites, or Directory and find the contact your want to call.
You can also use phone number, jid, or email.

2. Hover on the contact you want to call to reveal the click-to-call button and click
Call this contact.

Bria Enterprise makes the call.

To place a call using the Contact Info flyout

1. Type a name in Search Contacts, Search Favorites, or Search Directory or scroll
through Contacts, Favorites, or Directory and find the contact your want to call.
You can also use phone number, jid, or email.

2. Click on the contact or number you want to call. A Contact Info flyout with the
persons information opens.

3. Click the number you want to call in the Contact Info flyout.

Bria Enterprise makes the call.
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To place a call using the shortcut menu

1. Type a name in Search Contacts, Search Favorites, or Search Directory or scroll
through Contacts, Favorites, or Directory and find the contact you want to call.

2. Right-click (Windows) or CTRL+click (Mac) on the contact you want to call and click
Call or Video Call.

3. If the contact has more than one number, click the number you want to call.

Bria Enterprise makes the call.

To place a call using double-click

Double-click only works if the default action is set to Call or Make a video call. The action
for double-click is set in Preferences > Application: Default Actions.

1. Type a name, phone number, jid, or email in Search Contacts, Search Favorites,
or Search Directory or scroll through Contacts, Favorites, or Directory to find a
contact.

2. Double-click the contact or number that you want to call.

Bria Enterprise makes the call.

Using History
Make calls on Bria Enterprise from History using Make a call, using the shortcut menu,
or using the Contact Info flyout.

Making a call from the Contact Info flyout only works if the person is one of your
Contacts. You may want to use the Contact Info flyout when the person you want to call
is in History but you want to reach them at a different number than the one in History.
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To place a call using Make a call

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Click on the group to expand it.

3. Click Make a call.

Bria Enterprise makes the call.

To place a call using the shortcut menu

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Right-click (Windows) or CTRL+click (Mac) on the History group and click Call or
Video Call.

Bria Enterprise makes the call.
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To place a call using the Contact Info flyout

1. Type a name in the Search History or scroll through History and find a grouped
entry with the contact and number you want to call.

2. Click Contact Info.

3. Click the number on the Contact Info flyout that you want to call.

Bria Enterprise makes the call.

Using Messages
From the Messages windows, call the message sender or call a number in a message.

To place a call using Make a call and Make a video call buttons

1. With the All or People filter applied, click on the IM in the conversation list. Type a
keyword into Search to look for a specific message.

CounterPath an Alianza Company 24

Bria Enterprise User Guide Calls



2. Click Make a call or Make a video call in the IM header.

Bria Enterprise makes the call to the default number for the contact.

To place a call using the More options menu

1. With the All or People filter applied, click on the IM in the conversation list. Type a
keyword into Search to look for a specific message.

2. Click More options for this contact (Windows) or More options for this
conversation (Mac) in the IM header.
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3.

Click Call or Video Call. If the person has more than one number, select the
number you want to call.

Bria Enterprise makes the call.

To place a call using the shortcut menu

1. Right-click on an IM and select Call or Video call. If the person has more than one
number, select the number you want to call.

Bria Enterprise makes the call.
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To place a call to a number sent in an message

1. Click on the number you received in an IM.

Bria Enterprise makes the call.

From Microsoft Outlook
If you are using Outlook integration with Bria Enterprise, you can place calls directly from
Outlook.

You can place an audio or video call from the mini-contact card to an Outlook contact that
you have a phone number or softphone number for.

To place a call

1. Hover over a person’s name anywhere in Outlook. The mini-contact card appears.

2. Click on Call or Start video call.

Bria Enterprise places the call or video call and opens the call panel. If you clicked Start
video call, Bria Enterprise opens the Video window if the remote party answers the call
with video.

If a contact has more than one number, you can choose the number you want to call.

To place a call to a contact with multiple numbers

l Click the drop-down arrow beside Call or Start video call and select the
number that you want to call.
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Bria Enterprise places the call or video call and opens the call panel. If you clicked Start
video call, Bria Enterprise opens the Video window if the remote party answers the call
with video.

Selecting the account to use
The account selection options appear only if you have two or more SIP accounts enabled
and set up for phone calls.

The default Outgoing Account is Auto Select. Bria Enterprise selects the account based
on your dial plan rules. If there are no dial plan rules, Bria Enterprise will use the account
set as preferred in Softphone > Account Settings (Windows) or Preferences >
Account Settings (Mac).

To set your Preferred account for calls

1. Click Softphone > Account Settings (Windows) or Preferences > Account
Settings (Mac). The Account Settings window opens.

2. Select the account you want prefer to use from the Preferred account for calls
menu.

Bria Enterprise uses this account for outgoing calls if you do not have any dial plan rules
or have not explicitly chosen a different account.

You can also explicitly specify which account you want to use for an outgoing call.

To select the account for an outgoing call

1. Click Outgoing Account.

2. Choose the account you want to use from the menu.
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3. Place your outgoing call.

Bria uses the account you select for the outgoing call.

Note: Your system administrator may have set up a dial plan to select the correct dial out
account. Contact your system administrator for details.

Changing letters to numbers
Some phone numbers are given with words to help you remember them — “1-800-
numbers”. Rather than converting the letters to numbers in your head — n=6, u=8, m=6, …

to get 1-800-686-2377 — you can type letters into and Bria Enterprise will convert the
letters to numbers when placing the call.

To change letters to numbers

1. Click More call options.

2. Select Turn Letters to Numbers.
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Letters To Numbers is enabled  is displayed beside More call options and a
check mark appears beside Turn Letters to Numbers on the More call options
menu.

3. Type the phone number using numbers and letters.

4. Click Make a call or Make a video call.

The call panel opens and the call is placed. The call panel shows the phone number all in
numbers.

Hiding your identity
You can hide your identity on a call so that the remote party will not see your name or
number on their phone.

To hide your number

1. Click More call options.

2. Select Hide my Number.
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Anonymous Calling is enabled is displayed beside More call options and a check
mark appears beside Hide my Number on the More call options drop-down menu.
Your ID will be hidden for all outgoing calls until you turn off anonymous calling.

Changing video options
Video can be added or removed from an established call. If the remote party starts
sending video, your video window opens automatically and their video plays. Your video
is only sent to the remote party if you add it to the call.

To add video to an audio call
1. Click Start Video at the bottom of the call panel.

Bria Enterprise sends your video to the remote party. The remote party may or may not
send their video to you.

To stop and resume video
1. Click the Pause sending video icon at the bottom of the call panel or the video

window to pause or end your video. You can also close the video windows to stop
sending video. Closing the video window does not end the call.
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2. Click Start Video at the bottom of the call panel or on the video window toolbar or
the open the video window to resume sending your video.

Bria Enterprise starts or stops sending your video.

To show and hide the video preview
Bria Enterprise can show you a preview of the video you are sending.

1. Click on the video window if it is not in focus and hover over the video window.

2. Click the Toggle local video view icon.

Bria Enterprise toggles the local video view on and off.
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To expand and exit full screen video
1. Click on the video window if it is not in focus and hover over the video window.

2. To view in full screen click the Full screen or press F11 (Windows only).

3. To close full screen view click Exit full screen or press ESC (Mac only).

The video window screen changes size.

To change video settings
1. Click the Camera settings icon at the bottom of the video window.

2. Use the drop down menus to change your video device or change your video
resolution.

Bria Enterprise changes the video settings.
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Placing simultaneous calls
You can make up to five concurrent calls on Bria Enterprise.

To place a second call

To place a second call, use any of the methods for placing an audio or video call when
you have a call established. Bria Enterprise automatically puts the first call on hold and
dials the second call.

Bria Enterprise displays a call panel for each call.

To swap between calls

1. Click Take this call off hold on the call you want to switch to.

Bria Enterprise puts the active call on hold and switches to the other call.

Dealing with an auto attendant (Pause dialing)
You can use DTMF or pause dialing for auto attendant when you dial call or during a call.
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Using DTMF when you dial a call
If you know that your call will be answered by an auto attendant and you know what menu
items you will choose, you can include those menu items (DTMF) in the phone number
when you dial it.

Use the DTMF dialing rules to append the number you dial.

DTMF dialing rules

l Include at least one capital P before the first DTMF number. Each P causes Bria
Enterprise to pause for one second before sending the next character.

l You can include other P’s.
l At the end of the input, include a ; (semi-colon).

Note: Make sure to enter a ; (semi-colon) when you are done entering pauses and DTMF
numbers or Bria Enterprise will not be able to complete the call.

Examples

Example:
Example 1

To dial a number, add a 3-second delay and then press 44, enter this in the call entry
field:

6045551212PPP44;

Example:
Example 2
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To dial a number, add a 6-second delay, then press 1 then 3 then 2, each with a two
second delay:

6045551212PPPPPP1PP3PP2;

A capital X or a , (comma) can be used instead of P; the following will work in the
same way as the first example above.

6045551212XXX44;

Tip: You can save a number in this format in your contacts.

Using DTMF during a call
Once you have dialed a call, you may need to use DTMF to enter an extension number,
follow voice prompts, or enter a conference code.

The supported characters are: 0 1 2 3 4 5 6 7 8 9 A B C D * #

Note the alphabets are case sensitive and must be upper case.

Tip: You can also paste DTMF instead of typing. Use right-click to reveal Paste to DTMF.
CTRL+V is not supported.

To use DTMF during a call

1. Click Show/Hide DTMF.

The DTMF field opens.
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2. Type the required DTMF numbers.

Tip: Alternatively, copy the DTMF you want to type in, and right-click the DTMF
field to reveal Paste to DTMF. Click Paste to DTMF when you are ready to
send the tones.

3. Click Show/Hide DTMF to close the DTMF field.

Bria Enterprise plays the DTMF tones.

Handling an incoming call
Bria Enterprise must be running to answer incoming calls. It can be running in the system
tray. If Bria Enterprise is not running, incoming calls may be directed to voice mail if you
have this service. Check with your VoIP service provider or your system administrator.
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When Bria Enterprise is in the foreground, the call appears in the call panel in the Bria
Enterprise interface. When Bria Enterprise is in the either the foreground or the
background, you may also receive a notification for the incoming call depending on your
settings. To receive notifications on a Mac, also set the system preferences.

Answering on the call panel
You can answer a call on the call panel or using the notification.

To answer a call on the call panel

1. Click an action button.

One of the following results occurs depending on the action button you choose:

Icon and Meaning - Windows

Answer incoming call: The incoming audio call is answered with audio. If you were on
another call, Bria Enterprise places the first call on hold.

Answer incoming call with audio only: The incoming video call is answered with audio
only. If you were on another call, Bria Enterprise places the first call on hold.

Answer incoming call and start sending my video: The incoming video call is
answered with video. If you were on another call, Bria Enterprise places the first call on
hold.
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Forward this call to another person without answering: The incoming call is
forwarded without answering it first. A call entry field appears. Enter the name or number
you want to forward the call to and click Forward.

Refuse incoming call: The call is declined and the remote party gets a busy signal or
the call is forwarded to voice mail if you have this service.

Icon and Meaning - Mac

Answer call: The incoming audio call is answered with audio. If you were on another
call, Bria Enterprise places the first call on hold.

Answer with audio only: The incoming video call is answered with audio only. If you
were on another call, Bria Enterprise places the first call on hold.

Answer with video: The incoming video call is answered with video. If you were on
another call, Bria Enterprise places the first call on hold.

Forward call: The incoming call is forwarded without answering it first. A call entry field
appears. Enter the name or number you want to forward the call to and click Forward
Call.

Reject call: The call is declined and the remote party gets a busy signal or the call is
forwarded to voice mail if you have this service.

Answering notifications
In Windows, you will receive Windows 10 interactive toast notifications or Windows 7
style notifications. In Mac, you will receive banner style notifications or alert style
notifications.

To use Windows interactive toast notifications, you have to enable Use Windows
notifications in Softphone > Preferences > Alerts & Sounds.

To answer Windows 10 interactive toast notifications

1. Click Answer, Decline, or Decline with message in the interactive toast
notification. When you click Decline with message, the message you enter is sent
to the caller as an IM.
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To answer Windows 7 style notifications

You can answer a call with the notification by clicking Answer incoming call, Answer
incoming call and start sending my video, or Refuse incoming call.

To answer Mac notifications

Banner style notifications appear briefly in the top corner of the screen. They will
disappear on their own. To answer a call, click on the notification. This brings Bria
Enterprise into the foreground and you can answer the call using the call panel.

Alert styles notifications appear and remain on the screen until you take action on them.
You can click Answer or Decline on the alert. You can click anywhere else on the
notification to bring Bria Enterprise into the foreground and answer the call using the call
panel.
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The notifications do not indicate whether the incoming call is an audio call or a video call.
If the incoming call is a video call, Bria Enterprise will answer with video. If you do not
want video, you can stop sending video once the call is established.

Related features
Here is a list of features and preferences related to incoming calls.

l Display name on incoming calls

You can set Bria Enterprise to try to match your contacts and use the contact's
display name for the caller ID if a match is found. If you prefer you can use the SIP
call information. See Preferences > Calls - Caller ID.

To match contacts for caller ID

1. Click Softphone > Preferences (Windows) or Bria Enterprise > Preferences
(Mac).

2. On the Calls panel, select Match Contacts for Caller-ID.

Bria Enterprise attempts to match incoming calls to your contacts. If Bria Enterprise
finds a match, Bria Enterprise uses the Display name for the caller ID information.

l Call blocking

You can configure Bria Enterprise to block certain numbers.
l Call forwarding

Instead of answering, incoming calls can be forwarded to another number.
l Auto answer

Instead of clicking on the call panel, you can configure Bria Enterprise to
automatically answer calls.

l Call waiting

Call waiting notifies you of a new call while you are already on another call.

Enabling auto answer
You can turn on Auto Answer so the call is automatically answered by Bria Enterprise
after a specified period of time with no user intervention. Auto Answer is initially disabled.

You can enable this feature anytime, even during a call and it takes effect right away.
When you enable auto answer, Bria Enterprise automatically answers a call after 3

CounterPath an Alianza Company 41

Bria Enterprise User Guide Calls



seconds with audio only. You can customize the settings under Preferences >
Calls.configuration.

To enable Auto Answer

1. Click More call options.

2. Select Auto Answer.

Auto Answer is enabled is displayed beside More call options and a check mark
appears beside the Auto Answer on the More call options drop-down menu. Any new
incoming call are automatically answered.

To disable auto answer, click More call options and click Auto Answer. The Auto
Answer is enabled icon will disappear.

Disabling call waiting
You can turn on Disable Call Waiting so active calls are not interrupted by incoming
calls. You can enable this feature during a call and it will take effect right away. The calls
will appear as Missed Calls in the List of recent calls (Windows) or History (Mac). Any
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new incoming calls ring busy (to the caller) or go straight to voice mail if you have this
service.

To disable call waiting

1. Click More call options.

2. Select Disable call waiting.

Call Waiting is disabled is displayed beside More call options and a check mark
appears beside the Disable call waiting on the More call options drop-down menu.

Enabling call blocking
With this feature, Bria Enterprise blocks incoming calls with:

l No number,
l Anonymous Caller ID, and/or
l any number you added to the block list.

You can add up to 10 phone numbers in Bria Enterprise.

A SIP address with alphabets cannot be blocked.

Call History shows blocked calls.
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To enable call blocking

1. Click Softphone > Preferences (Windows) or Bria Enterprise > Preferences
(Mac).

2. On the Calls panel under Call Blocking, select the desired option(s).
l Block incoming calls with no number
l Block incoming calls with anonymous Caller ID

3. Add phone numbers to block, if desired. Type a number in the box and press
ENTER.

To add a phone number to the block list from History

1. Scroll through History and find a grouped entry with the number you want to block.

2. Right-click (Windows) or CTRL+click (Mac) on the History group and click Block
number.

Bria Enterprise blocks incoming calls from this number.
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Transferring a call
Transferring a call means you are in a call and you want to hand this call over to someone
else (the target). Forwarding a call is something different; it means you redirect an
incoming call to another number without answering the incoming call. Another number
could be your mobile phone number, or someone else's number.

Two types of call transfer
There are two types of call transfers. A unattended or blind transfer occurs when you
transfer a call without talking to the target – the person you are sending the call to. An
attended transfer occurs when you talk to the target before transferring the call.

The Bria Enterprise transfer button can be set with Transfer Now or to Call First as the
default. You can set the default in the Preferences: Application panel

Unattended transfer
In an unattended or blind transfer, you transfer the call to the target without talking to the
target first.

To transfer a call

1. Click Transfer this call (Windows) or Transfer (Mac) at the bottom of the call
panel. Bria Enterprise puts the call on hold.

2. Type the name or number of the target, use the redial drop-down list, or drag the
target’s contact into the Enter name or number field.
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3. Click Transfer Now if it is your default or click the drop-down arrow beside Call
First and click Transfer Now.

Bria Enterprise attempts to transfer the call to the target. The call may end immediately or
may show Transfer: Calling. If you see Transfer: Calling, do not hang up. If the target
does not answer, the call will return to you.

Attended transfer
Transfer the call to the target after speaking to the target.

To transfer a call

1. Click Transfer this call (Windows) or Transfer (Mac) at the bottom of the call
panel. The call is put on hold.

2. Type the name or number of the target, use the redial drop-down menu, or drag the
target’s contact into the Enter name or number field.
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3. Click Call First if it is your default or click the drop-down arrow beside Transfer
Now and click Call First.

Bria Enterprise phones the target. When the target answers, Transfer Now is
enabled

4. Speak to the target. If the target wants to take the call, click Transfer Now
(Windows) or Transfer now (Mac). If the target does not want to take the call,
click the X at the bottom of the call panel.

Bria Enterprise transfers the call to the target if the target accepts the call.

Forwarding a call
Forwarding a call means you redirect an incoming call to another number without
answering the incoming call. Another number could be your mobile phone number, or
someone else's number.
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Call forwarding can be handled by the call server, or the Bria Enterprise softphone client.
Configure just one of them, not both. You can also manually forward a call on the fly on
each incoming call even when you haven't set up call forwarding.

Server-side call forwarding
If your VoIP service provider supports call forwarding handled by their call server, follow
their instructions to enable it.

Client-side call forwarding
Client-side call forwarding works only when Bria Enterprise is running and only if your
VoIP service provider supports redirect. See Voicemail panel (SIP).

Forwarding a call manually
When you receive an incoming call on Bria Enterprise, you can forward it instead of
answering it. Calls show up as missed calls in History.

To forward a call on the fly

1. Click Forward call on the call panel.

2. Type the name or number of the target, use the redial drop-down list, or drag the
target’s contact into the Enter name or number field.

Bria Enterprise forwards your call.

Encrypting a call
The outgoing call may be encrypted depending on your security settings.

l If an encrypted call is established, the security lock appears on the call panel.
l If an unencrypted call is established, no encryption icon appears.
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Note: If a call cannot be established using the specified security, the call will fail.

Recording a call
You can record the audio portion of a one-to-one call or a conference call. Recording are
saved as .wav files on your computer. Your administrator sets up the location where the
recordings are saved.

Files created for conference calls

Multiple files may be created depending on how and when you start recording. If you start
recording from the beginning of a conference call and continue recording until the call
ends, one file is created.

If you separate a participant from the conference call and have a one-to-one call, the
recording continues until the end of the one-to-one call. Two files are created: one for the
conference call and the other for the one-to-one call.

Files created when forming conference calls from one-to-one calls

If you are recording one-to-one calls and you merge them to form a conference call, all
the individual recordings stop and a new recording is created for the conference call.

If you are recording one-to-one calls and you add them to an existing conference call, all
the individual recordings stop. If the conference call was being recording before the
merge, the recording of the conference call continues.

Creating a call recording
You can record the audio portion of a call in progress.
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To start a call recording

1. Click More options for handling this call (Windows) or More options (Mac).

2. Click Start Call Recording.

Bria Enterprise starts recording the call. The call panel shows a call recording indicator.

Stopping recording a call
You can stop recording a call using the More menu or using the recording icon.
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To stop recoding a call using the More menu

1. Click More options for handling this call (Windows) or More options (Mac).

2. Click Stop Call Recording to end the call recording.

Bria Enterprise stops recording the call.

Using the Stop Call Recording

1. Click the Stop Call Recording.

Bria Enterprise stops recording the call.

The first time you record a call, a Save Call Recording dialog appears. The dialog
displays the Recording name and the Saved in location. You can select Don’t show this
dialog again if you do not want to see the dialog after every recorded call. Click Open
Folder to open the folder where the file is saved.
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Playing back a call recording
You can play a call recording back directly from Bria Enterprise using History or you can
use a file explorer and your default app to play the recording.

To play back a recording using History

1. Go to the History tab on the resource panel.

2. Optional: Click on the filter and select Recordings.

3. Click on the History group that contains the recording. The History group expands.

4. Click on the call entry that contains the recording. The call entry expands.

5. Click Play Recording.

Bria Enterprise plays the recording in your default audio player.
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To play back a recording using file explorer

1. Locate the .wav file from the location it was saved in.

2. Double-click on the file. The file opens in your default audio player.

3. Use the controls in the audio player to play back the recording.

The recording is played in the default audio player.

Ending a call
You can end a call from the call panel, from the taskbar, from the dock, or from the video
window.

To end a call from the call panel

1. Click End call.

The call ends and the panel closes after a few seconds.

To end a call from the taskbar (Windows)

1. Right-click on the Bria Enterprise icon in the taskbar.

2. Click End Call.

The call ends and the panel closes after a few seconds.
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To end a call from the dock (Mac)

1. CONTROL+click on the Bria Enterprise icon in the dock.

2. Click End Call.

The call ends and the panel closes after a few seconds.

To end a call from the video window

1. Click End call in the video window tool bar.

The call ends and the panel closes after a few seconds.
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Conference calls

Creating a conference call
You can create a conference call or you can add participants to an existing call. Once a
conference call is created, you can add additional participants.

Creating a conference call
Create a conference call without an established call.

To create a conference call using the dialer

1. Type a number in Enter name or number.

2. Click More call options beside Make a call or Make a video call and select
Start Conference Call.

Bria Enterprise connects the first participant.
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3. Type a name or a number, use the redial drop-down, or drag a contact into the
Enter name or number field and click Add.

Bria Enterprise starts a three-party conference call.

4. To add more participants, click More options for handling this call (Windows) or
More options (Mac) and click Invite to Conference Call.

5. Enter a name or a number, use the redial drop-down list, or drag a contact into
Enter name or number at the bottom of the call panel and click Add.

Bria Enterprise adds the new participant.

6. Repeat steps 4 and 5 until you have added all the participants to the conference
call.

Bria Enterprise creates a conference call.
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Adding participants to an established call
You can add participants to a one-on-one call or to an existing conference call.

Adding participants to an active call

You can use the More options for handling this call (Windows) or More options
(Mac) from an existing one-on-one call or from an existing conference call.

Using the More menu

1. Click More options for handling this call (Windows) or More options (Mac)
and click Invite to Conference Call from an established call.

2. Type a name or a number, use the redial drop-down, or drag a contact into Enter
name or number and click Add. Bria Enterprise adds the new participant.
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3. Repeat steps 1 through 3 until you have added all the participants to the conference
call.

Bria Enterprise creates a conference call.

Merging existing calls

You can create a conference call by merging two or more existing calls.

To add participants by merging calls

1. Establish the calls you want to merge.

2. On the active call, click More options for handling this call (Windows) or
More options (Mac) and click Merge Calls.

Bria Enterprise creates a conference call.
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Using the shortcut menu in Contacts or Favorites

You can add participants to an established one-on-one call or to an established
conference call using the shortcut menu in Contacts or Favorites.

To add participant using the shortcut menu

1. During an established call, go to the Contacts or Favorites panel.

2. Right-click (Windows) or CTRL+click (Mac) on a Contact or Favorite and click Add
to Call.

Bria Enterprise creates a conference call.
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Using the shortcut menu in History

You can add participants to an established one-on-one call or to an established
conference call using the shortcut menu in History.

To add participants by using the shortcut menu

1. During an established call, go to the History panel.

2. Right-click (Windows) or CTRL+click (Mac) on a History entry – expanded or
collapsed - and click Add to Call.

Bria Enterprise creates the conference call.

External conference call
To join a conference call external to Bria Enterprise, you may need to enter DTMF digits.
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To use DTMF during a call

1. Click Show/Hide DTMF.

The DTMF field opens.

2. Type the required DTMF numbers.

Tip: Alternatively, copy the DTMF you want to type in, and right-click the DTMF
field to reveal Paste to DTMF. Click Paste to DTMF when you are ready to
send the tones.

3. Click Show/Hide DTMF to close the DTMF field.
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Bria Enterprise plays the DTMF tones.

Video conference calls
To use video conferencing, a video camera is necessary to allow the remote parties to
see your image. Bria Enterprise works with most USB video cameras. Video is sent to all
participants in a conference call.

Including video in a conference call
When you start a conference call from established calls, video is automatically included if
at least one of the established call includes video.

When you create a new conference call, video is not included. You (the host) must add
video to the new conference call as participants do not have the ability to do so.

To add video to a conference call

1. Click Start Video.

Video is sent to all conference participants. Participants can choose whether to share
their own video.

How video is shared
The conference host, the person who started the conference call, serves as the host for
the video feed. The video that the host sees is automatically sent to all participants.
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If the conference host pauses or stops the video, the other participants no longer receive
video.

One person does not have video
Participants that have video see Video beside their name. If there are any participants
that do not have video, the host must stop and start the video.

Sending an instant message to a conference
participant
Send individual instant message (IM) to a conference participant.

To send a participant an instant message (IM)
during the conference call
1. On an established conference call, click Send Instant Message beside the

name of the participant.

The Messages window opens.
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2. Type the message in the Compose Message field.

3. Click Send Message or press ENTER.

Bria Enterprise sends the IM.

Putting a conference on hold
With Bria Enterprise, you can put a conference call on hold.

To put a conference call on hold

1. Click Put conference call on hold at the bottom of the conference call panel.

Bria Enterprise places the conference call on hold.
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To resume a conference call

1. Click Take all participants off hold at the bottom of the conference call panel.

Bria Enterprise takes the conference call off of hold.

Speaking to a participant separately
During a conference call, you can speak to one of the conference participants separately
while maintaining the conference call.

To speak to one participant in a conference call

1. Click Separate Calls beside the participant you want to speak to.

The conference is split into two calls. When you are finished speaking to the separate
participant, you can merge the two calls back into the conference call or end the one-on-
one call and return to the other conference call.
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Removing a participant or ending a
conference call
You can remove a participant from the conference call and continue with call or you can
end the conference call.

To remove a participant

1. Tap End call beside the participant you want to remove.

Bria Enterprise ends the call with the participant. The call continues with the remaining
participants.

To end a conference call

1. Click End call from the conference call panel.

Bria Enterprise ends the conference.
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Accessing voicemail

Voicemail is offered through your VoIP service provider or through your enterprise’s IP
PBX. It is not part of Bria Enterprise. Contact your VoIP service provider or your system
administrator for information on using voicemail. If your service includes voicemail, your
system administrator can set up voicemail options to access your provider's voicemail
using Bria Enterprise.

Listening to voice messages
When you have a new message, an icon showing the number of messages shows on
Voice messages (Windows) or Voice Mail (Mac) if Bria Enterprise has been set up
with the number to call to check voicemail. If it has not been set up, contact your service
provider to find out how to access voicemail.

To listen to your messages

1. Click Voice messages (Windows) or Voice Mail (Mac).

Bria Enterprise plays your messages.

Multiple SIP accounts
If you have multiple SIP accounts registered, clicking the Voice messages (Windows)
or Voice Mail (Mac) button reveals the number of messages for each SIP account.
Click the account that you want to hear the messages from.
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Messaging

There are three types of messages in Bria Enterprise - instant messages (IMs), broadcast
IMs, and chat rooms.

l IMs are messages that you send to an individual contact.
l Broadcast IMs are messages that you send to more than one contact at once. Each
recipient can reply to the IM but only you will see these replies.

l Chat rooms have multiple members and allow you to send messages to all the
members of the room. The messages each member sends are seen by everyone.

You can see chat rooms with either the All or the Rooms filter selected in the Messages
window. You can see IMs with either the All or the People filter selected in the Messages
window. You can see broadcast IMs with either the All or the B-casts filter selected in the
Messages window.

You can send IM's to any contact who has a softphone (if your SIP provider supports SIP
SIMPLE) or an XMPP address. To use chat rooms, you must have an XMPP account
registered and enabled.
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If you do not have an XMPP account registered and enabled, there are no filters in the
Messages window.

You can use emoticons and formatting in your IM's and chat rooms. Use CTRL+B for bold,
CTRL+I for Italic, and CTRL+U for underline on Windows. Use COMMAND+B for bold,
COMMAND+I for Italic, and COMMAND+U for underline for Mac.

By default, SHIFT+ENTER (for Windows) or CONTROL + ENTER (for Mac) inserts a new
line in a message and ENTER sends the message. You can modify this behavior in
Preferences > Application panel: Messages & Presence.

Opening the Messages window
There are several ways that you can open the Messages window.

Windows

l Click Show the messages window.

l Keyboard accelerator: SHIFT+CTRL+M
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l Select View > Messages

l Click on an IM notification

Mac

l Click Show the messages window.

l Keyboard accelerator: SHIFT+COMMAND+M
l Select Window > Show Messages

l Click on an IM notification
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Instant messages
You can send instant messages (IMs) to a contact who has a softphone address (if your
provider supports SIP SIMPLE) or an XMPP address. You can delete the entire IM
session.

To send messages to more than one person, see Broadcast IMs or Chat rooms.

Sending and receiving instant messages

Sending an instant message

Instant messages (IMs) can be sent from the Messages window, the Contacts panel, the
Favorites panel, or from an active call.

Set the action for clicking ENTER while typing a message in Preferences > Application
panel: Messages & Presence.

Sending an IM from the Messages window

From the Messages window, you can start a new IM, send another message on an
existing IM conversation, or send an IM to a member of a chat room.

When you send an IM using New Conversation, you may see Add a Favorite. This
only shows up if you have added a person to Favorites.

To send an IM using New Conversation

1. Click New Conversation.

The new conversation window opens.
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2. Type the name of a person in Type to add people to a conversation and select
them from the list of suggestions when they appear. Type ENTER to select the first
suggestion in the list. If you have added any contacts to Favorites, you can also
click on the person in Add a Favorite.

3. Click on the person below Send a Message. Type ENTER to select the first
suggestion in the list.

4. Type your message in Compose Message.

5. Click Send Message.

Bria Enterprise sends the IM.

Add to an existing IM conversation

1. Do one of the following:

l Scroll to find the IM conversation

With the All or People filter selected, scroll through the conversations and
click on the IM conversation.

l Search with the People filter

With the People filter selected, type the name of the person you want to IM in
Search. All IM conversations that have the person's name in them appear –

including conversations where the name was mentioned in a message. Click
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on the IM conversation.

l Search with the All filter

With the All filter selected, type the name of the person you want to IM in
Search. All IM conversations and group chats that have the person's name in
them appear – including conversations where the name was mentioned in a
message. Click on the IM conversation.

2. Type your message in Compose Message.

3. Click Send Message .

Bria Enterprise sends the IM.

To send an IM from a chat room

1. Click on the chat room with the All or Rooms filter selected.

2. Click Members in the chat room header. The number indicates the number of
members in the room.

3. Do one of the following:

l Single click

Click on their avatar and click on Instant Message on the vCard.

l Double click

Double click on their avatar.
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If you already have an existing IM conversation, Bria Enterprise opens it. If you do
not have an existing IM conversation, Bria Enterprise starts a new one.

4. Type your message in Compose Message.

5. Click Send Message .

Note: If you do not have an XMPP account or your XMPP account is not registered, there are
no filters.

Sending an IM from the Contacts or the Favorites panel

From the Contacts or Favorites panel, you can send an IM using the shortcut menu or
using click-to-message.

To send an IM using the shortcut menu

1. On the Contacts or Favorites panel, right-click (Windows) or CONTROL+Click (Mac)
on a contact or a favorite and select Send Instant Message from the shortcut
menu. If there is more than one IM address, select the one you want to use.
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2. Type your message in Compose Message.

3. Click Send Message.

Bria Enterprise sends the IM.

To send an IM using click-to-message

1. On the Contacts or Favorites panel, hover on the contact you want to message to
reveal the click-to-message button. Click Instant message this person.

2. Type your message in Compose Message.

3. Click Send Message.

Bria Enterprise sends the IM.
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To send an IM from the vCard

1. On the Contacts or Favorites panel, click the person you want to message. Their
vCard opens.

2. Click Instant Message.

3. Type your message in Compose Message.

4. Click Send Message.

Bria Enterprise sends the IM.

Sending an IM from an active call

From an active call, you can send an IM using More options for handling this call
(Windows) or More options (Mac).

To send an IM from an active call

1. During an active call, click More options for handling this call (Windows) or
More options (Mac) in the call panel and click Send Instant Message.
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2. Type your message in Compose Message.

3. Click Send Message .

Bria Enterprise sends the IM.

Tip: If Preferences > Application panel: Messages & Presence > In messaging, pressing
Enter will: is set to Send the message, you can use ENTER instead of clicking Send
Message.

Receiving an instant message

When you receive an IM, the Messages window opens or a notification appears. To
control the type of notification, go to Preferences >Alerts & Sounds (Windows) or
Preferences > Alerts (Mac) .

Windows 10 interactive toast notification

You can type your response directly into a Windows 10 interactive toast notification or
you can click on the notification to open it in the Messages window.

Windows 7 and Mac notifications

You click on the Windows 7 or a Mac IM notification to open it in the Messages window.
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Sharing files
Send and receive files with your XMPP contacts using Bria Enterprise. To use XMPP file
transfer, the recipient needs to have their XMPP account enabled.

Sending files

You can send a file:

l Using the shortcut menu
l By dragging a file to an IM session

To send a file using the shortcut menu

You can use the shortcut menu to send files from the Messages window, contacts, and
favorites.

1. Right-click (Windows) or CTRL+Click (Mac) on a contact or favorite and click Send
Files. The file manager opens.

2. Find the file you want to send. Double-click the file or click the file and click Open.

The progress bar appears in the Messages window along with the file name. Bria
Enterprise waits for the recipient to accept the file transfer. To cancel the transfer, click
Cancel.
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To send a file by dragging it to an IM session

1. Open your file manager and locate the file you want to transfer.

2. Drag the file into an IM session on the Messages window.

The progress bar appears in the Messages window along with the file name. Bria
Enterprise waits for the recipient to accept the file transfer. To cancel the transfer, click
Cancel.

Receiving files

If you have an XMPP account enabled, another person with an XMPP account can send
you files.

1. The following message appears in the Messages window when the other party
initiates the transfer.

2. Click Accept to start receiving the file. To stop the transfer, click Cancel.

3. When the transfer is complete, click Open Folder, then locate the download file to
open it.

CounterPath an Alianza Company 79

Bria Enterprise User Guide Messaging



Sending a screen capture
Use Bria Enterprise to send a screen capture as an IM to a single recipient using your
XMPP account. The recipient must be online. The recipient receives the screen capture
as a file transfer.

To send a screen capture

1. Click Start Screen Capture beside Compose Message.

2. Click and drag to highlight the area you want to capture. The area you select
appears lighter than the surrounding area.

3. click Send Screen Capture over IM when you have selected the area you want
to send. If you are unhappy with the screen capture, you can click Cancel Screen
Capture or Redo Screen Capture.

Bria Enterprise sends the screen capture to the message recipient

Deleting instant messages
You can delete an IM conversation from Bria Enterprise. Before you delete a
conversation, you may want to export it.
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To delete a conversation using Delete Conversation

1. Click Delete Conversation on the conversation.

A Delete Conversation dialog opens.

2. Click Yes or OK.

Bria Enterprise deletes the conversation. If synchronization is enabled, the conversation
is removed from all of your devices.

To delete a conversation using the More menu

1. With the All or People filter applied, click on the IM in the conversation list.

2. Click More options for this contact (Windows) or More options for this
conversation (Mac) in the conversation header.

3. Click Delete Conversation.
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A Delete Conversation dialog opens.

4. Click Yes or OK.

Bria Enterprise deletes the conversation. If synchronization is enabled, the conversation
is removed from all of your devices.

To delete a conversation using the shortcut menu

1. Right-click on the session and click Delete Conversation.

A Delete Conversation dialog opens.
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2. Click Yes or OK.

Bria Enterprise deletes the conversation. If synchronization is enabled, the conversation
is removed from all of your devices.

Tip: If you select Don’t show this warning again before clicking Yes or OK on the Delete
Conversation dialog, you will not receive a warning before deleting sessions in the future.

Broadcast IMs
With an XMPP account enabled, you can send a broadcast message to multiple contacts
at one time. A broadcast IM is not a chat room;

l With a broadcast IM, each recipient can reply to the IM but only you will see these
replies. Other recipients will not see these replies.

l With a chat room, all parties will see everyone's messages and the messages each
party sends are seen by everyone.

To send a broadcast message using New Conversation

1. Click New Conversation.

The new conversation window opens.
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2. Type the name of a person in Type to add people to a conversation and select
them from the list of suggestions when they appear. Type ENTER to select the first
suggestion in the list. If you have added any contacts to Favorites, you can also
click on the person in Add a Favorite.

3. Repeat the previous step to add more people.

4. Click Send a Broadcast.

5. Type your message in Compose Message.

6. Click Send Message.

Bria Enterprise sends a message to the recipients.

Chat rooms
Chat rooms are used when sending messages to multiple recipients. Chat rooms can be
private or public. Private rooms can only be joined by invitation. Public rooms can be
joined by anyone in your XMPP group. Chat rooms are only supported with a single
XMPP account.

You can:

l Create chat room.
l Join a chat room.
l Set up the type of notifications you want to receive for each chat room.
l Use mentions to get the attention of a specific chat room member.
l Add and remove members.
l Delete or leave a chat room.
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Chat room server requirements
The following requirements must be met to use chat rooms:

l Your XMPP server must support:
l Multi-User Chat as defined in XEP-0045.
l Bookmarks as defined in XEP-0048.
l Private XML Storage as defined in XEP-0049.
l Entity Time as defined in XEP-0202
l Delayed Delivery as defined in XEP-0203

l All the clients must be running version 5.5.0 or higher on Windows and Mac and
version 5.5.3 or higher on iOS and Android.

l All the users must connect to the same XMPP server; in other words, their XMPP
accounts must have the same domain.

l Your XMPP account must be registered and enabled.

If your XMPP server does not support XEP-0045, you will not see Rooms in Messaging.

If your XMPP server does not support XEP-0048, XEP-0049, XEP-0202, and XEP-0203,
chat rooms may not work as designed. Users may see errors in the Rooms list, the time
stamps on messages may be incorrect, and some messages may not be sent to all users.

If some clients are running versions earlier than 5.5.0 on Windows and Mac and version
5.5.3 on iOS and Android, the room members list may not accurately show who is in the
chat rooms and messages may not be sent to all room members.

Chat room properties
Each chat room has a set of properties. Some are required and some are optional.

Required chat room properties

Room name: Each room must have a unique room name. Up to 40 characters long.

Room Type: A room can be private or public. Private rooms are unlisted and can be
joined by invitation only. Public rooms are displayed in the list of chat rooms that you can
join.

Room owner: The name of the person that created the room.
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Optional chat room properties

Members: The people you are inviting to the room or the people already in the room.

Description: Up to 140 characters long that can be edited by the room owner.

Topic: A brief description of what is currently being discussed in the group that can be
edited by anyone. Up to 140 characters long.

Creating a chat room
All Bria Enterprise users can create new private or public chat rooms. Private chat rooms
can only be joined by an invitation from the Room Owner. Public chat rooms can be
joined by anyone.

Chat rooms are assigned an avatar using the initials from Room Name. As you type in
Room Name, the color of the avatar changes. The resulting color is assigned to the chat
room. Room Name can be up to 40 characters long and must be unique. Room Name is
case sensitive.

Description is an optional field. Description can be up to 140 characters long.

Creating a private chat room

You can create a private chat room from the Messages window, Contacts or Favorites.
When you create a private chat room, you invite people to join the room.

To create a private room using the New Conversation button

1. Click New Conversation.

The new conversation window opens.

2. Optionally, type the name of a person you want to add to the room in Type to add
people to a conversation and select them from the list when they appear. Repeat
this for all users you want to add to the room. You can also add members later in the
Create a Room window.
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3. Click Create a Room.

Any contacts entered into Type to add people to a conversation appear in
Members.

4. Type in a Room Name.

5. Optionally, add additional members to the room. Start typing the name of a contact
you want to add to the room. As you type a name, Bria Enterprise shows a list of
suggestions. Select the person you want to invite from the list.

If you want to remove someone from Members before you create the room, click
Remove.

6. Repeat the previous step until all the members you want to add are shown in
Members.

7. If desired, enter a brief Description of the room. This field is optional.

8. Click Create.
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Bria Enterprise creates the room and displays the conversation. The Members you
invited are automatically added to the room. The lock on the avatar for the room indicates
this is a private room.

To create a private room from an IM

1. From All or People on the sidebar, select the IM you want to create a room from.

2. Click Create a Chat Room in the IM header.
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3. Select Private for the Room Type.

4. The Room Name defaults to your display name. If desired, type in a new Room
Name.

5. The person from the one-to-one is automatically added to Members.
Start typing the name of another a contact you want to add to the room. As you type
a name, Bria Enterprise shows a list of suggestions. Select the person you want to
invite from the list.

If you want to remove someone from Members before you create the room, click
Remove.

6. Repeat the previous step until all the members you want to add are shown in
Members.

7. If desired, enter a brief Description of the room. This field is optional.

8. Click Create.
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Bria Enterprise creates the room and displays the conversation. The Members you
invited are automatically added to the room. The lock on the avatar for the room indicates
this is a private room.

To create a private room in Contacts or Favorites

1. Click a group, or use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac)
or a combination to select two or more contacts, favorites, or groups.

2. Right-click (Windows) or CTRL+click (Mac) and select Create a Chat Room….

Create a Room opens.
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3. Select Private for the Room Type.

4. Room Name defaults to your display name followed by Room. You can edit Room
Name by typing in a new name.

5. The contactsyou selected are listed in Members.

If you want to add any additional contacts, start typing the name of a participant you
want to add to the room. As you type a name, Bria Enterprise shows a list of
suggestions. Select the person you want to invite from the list.

If you want to remove someone from Members before you create the room, click
Remove.

6. Repeat the previous step until all the members you want to add are shown in
Members.

7. If desired, enter a brief Description of the room. This field is optional.

8. Click Create.

Bria Enterprise creates the room and displays the conversation. The Members you
invited are automatically added to the room. The lock on the avatar for the room indicates
this is a private room.
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Creating public chat rooms

You can create a public room from the Messages window, Contacts or Favorites. Once
the room is created, anyone can invite members to join the room.

To create a public room using the New Conversation button

1. Click New Conversation.

The new conversation window opens.

2. Click Create a Room.

3. Select Public for the Room Type.

4. Type in a Room Name.

5. If desired, enter a brief Description of the room. This field is optional.

6. Click Create.
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Bria Enterprise creates the room and adds it to the list of conversations. Your contacts
can join the room.

To create a public room from an IM

1. From All or People on the sidebar, select the IM you want to create a room from.

2. In the IM header, click Create a Chat Room.
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3. Select Public for the Room Type.

4. The Room Name defaults to your display name. If desired, type in a different Room
Name.

5. If desired, enter a brief Description of the room. This field is optional.

6. Click Create.

Bria Enterprise creates the room and adds it to the Rooms section of the Messages
window. Your contacts can join the room.

Tip: You can select any IM to create a public room. Public rooms are do not have members so
you don't need to select a specific Contact or Favorite.
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To create a public room in Contacts or Favorites

1. Right-click (Windows) or CTRL+click (Mac) on any Contact or Favorite and select
Create a Chat Room….

Create a Room opens in the Messages window.

2. Select Public for the Room Type.

3. The Room Name defaults to your display name. If desired, type in a different Room
Name.

4. If desired, enter a brief description of the room. This field is optional.

5. Click Create.

Bria Enterprise creates the room and adds it to the Rooms section of the Messages
window. Your contacts can join the room.
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Tip: You can select any Contact or Favorite to create a public room. Public rooms are do not
have members so you don't need to select a specific Contact or Favorite.

Joining a chat room
There are two types of chat rooms - public and private. Anyone can join a public chat
room. You must be invited to join a private chat room. Bria Enterprise automatically
accepts the invitation to private chat rooms.

When you join a chat room, all the messages from the room are available to you. You can
continue to scroll through and download the message history until you see No more
messages.

Joining a private chat room

In order to join a private chat room, you have to be added as a member. You
automatically join the room when the Room Owner invites you. When you select either
All or Rooms on the sidebar, the private chat room appears at the top of the list of
conversations. If there are any messages in the room, you also see a new message
indicator.
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Joining a public chat room

You can join existing public chat rooms that were created by one of your contacts.
Anyone in a public chat room can invite people to join the room. The invitation is sent as
an IM to each person invited.

To join a public chat room by searching for the room

1. Click New Conversation.

The new conversation window opens.

2. Click Join room beside the public room you want to join.

If you want to join multiple rooms at the same time, click Join room beside all the
public rooms you want to join.

If the list of rooms is long, you can type room name and description keywords in
Search.

Click on More Info to view who created the room, when is was created, and the
Description (if one was added).

3. Once you have added all the rooms you want to join, click Close.
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The chat room is added to the Rooms section of the Messages window.

To join a public chat room from an invitation

1. Click on the IM with the invitation for the public room.

2. Click Join.

The chat room is added to the Rooms section of the Messages window.

Editing chat rooms
After a room has been created, the Room Owner – the person that created the room – can
change the Room Name and Description, add new members, and add a Topic to a
room. These changes are made from the Messages window.

Members of the room can also change the Topic.

CounterPath an Alianza Company 98

Bria Enterprise User Guide Messaging



Changing the Room Name and Description

The Room Owner can change the Room Name and Description.

To change the Room Name and Description

1. With the All or Rooms filter applied, click on the chat room in the list of
conversations.

2. Click Settings in the chat room header.

3. Type a new Room Name or Description.

4. Click Update.

Bria updates the Room Name and Description.

Adding a Topic to a room

Roommembers can add a Topic for both public and private chat rooms. You might want
to add a Topic to indicate what the current discussion is about. Topics do not show up in
search results.
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To add a Topic to a room

1. With the All or Rooms filter applied, click on the chat room in the list of
conversations.

2. Click on Add a topic or on the existing topic.

3. Type in the new Topic.

Bria Enterprise displays the new topic in the chat room header when the chat room is
selected.

Chat room notifications
Bria Enterprise has several ways to indicate when there is a new message or you have
been mentioned in a chat room you are a member of. You can customize the notifications
the you receive in Preferences >Alerts & Sounds (Windows) or Preferences > Alerts
(Mac) and for each chat room.

Types of notifications

Bria Enterprise may do the following depending on how you set your Preferences and the
notifications for each chat room:
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l Send a notification or open the Messages window when there is a new message if
Notifications is set to All for the chat room.

l Send a notification or opens the Messages window where the user has been
mentioned in a message if Notifications is set to All or to Mentions (@) for the chat
room.

l Cause the icon to flash in the Taskbar or bounce in the Dock when there is a new
message if Notifications is set to All for the chat room.

l Cause the icon to flash in the Taskbar or bounce in the Dock when the user has
been mentioned in message if Notifications is set to Notifications is set to All or to
Mentions (@) for the chat room.

l Display a badge with the number of new messages on the onscreen phone.

l Display a dot beside All, Rooms, and beside the chat room in the conversation list
on the Messages window when there is a new message.
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l Display @ beside the chat rooms in the Rooms list on the Messages window when
the user has been mentioned.

Changing chat room notifications

You can change the notifications you receive for each individual chat room. Choose from:

l All: Bria Enterprise notifies you if there is a new message or you have been
mentioned in a chat room you are a member of.

l Mention (@): Bria Enterprise notifies you if you are mentioned in a chat room you
are a member of.

l None: Bria Enterprise does not notify you that there is a new message or that you
have been mentioned in a chat room you are a member of.

To change room notifications from the Rooms list

1. Right-click (Windows) or CTRL+click (Mac) on the chat room in the Rooms section
of the Messages window.

2. Select Notifications and the type of notification that you want to receive — All,
Mentions (@), or None.
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Bria Enterprise updates your notification preferences for the room.

To change room notifications from room options

1. Click on the chat room in the Rooms section of the Messages window.

2. Click More options for this conversation.

3. Select Notifications and the type of notification that you want to receive — All,
Mentions (@), or None.

Bria Enterprise updates your notification preferences for the room.

Sending and receiving messages

Sending a message

Once you have created or joined a chat room, you can start sending messages.
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To send a chat room message

1. Click on the chat room in the Rooms section of the Messages window.

2. Type you message in Compose Message.

3. Click Send Message.

Bria Enterprise sends the chat room message.

Seeing someone else is typing

You will see an indication in the chat room message area when someone is typing a
response.

Receiving a message

Your chat room notification settings determine the type of alert you see when there is a
new message on a chat room.

To view a new message

l Click on the chat room in the Rooms section of the Messages window.
l Click on the notification.

Bria Enterprise displays the chat room messages.

Mentions

If you want to get the attention of a room member, you can use mentions. The person that
is mentioned sees an indicator beside the chat room in the Rooms section of the
Messages window and sees their name highlighted in the chat room messages.
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To mention a person

1. Click on the chat room in the Rooms section of the Messages window.

2. Type@ followed by the name of the person you want to mention in Compose
Message. As you type, Bria Enterprise offers suggestions. Click on person from the
list of suggestions or use the up and down arrows to highlight a person in the
suggestions list and use TAB to select them. If you type TAB without using the
arrows, the first person in the list of suggestions is selected.

3. Type you message in Compose Message.

4. Click Send Message.

Bria Enterprise sends the chat room message. The person mentioned in the message
sees an indicator that they have been mentioned.

Tip: You can use@Everyone to send a mention to all members of a private chat room and all
active members of a public chat room.
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Chat room members
Members of a chat room can see who is in the room. Anyone in the chat room can invite
new members to a public chat room. The owner of the chat room can add new members
to a private room. The room owner can also re-invite members to a private chat room and
remove private chat room members.

Seeing who is in a room

As a member of a chat room, you can see who is in the room. Private chat rooms display
everyone who is a member of the chat room along with their status. Public chat rooms
display the room members that are currently online.

To see who is in a chat room

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Members in the chat room header. The number indicates the number of
members in the room.

The members list opens in the chat room panel. Each member of the chat room is
displayed with their status. Hover over the avatar for the members name. Click on the
member to see the contact details.
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Seeing who the room owner is

You may need to find out who the room owner is so you can ask them to invite another
person to a private chat room.

To see who the room owner is

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Settings in the chat room header.

Room Owner displays in Room Settings.

Adding new members to a chat room

You can add members to chat rooms using the chat room header or from the chat room
settings.

Adding members from the header

Using the chat room header, you can add members to both private and public rooms.
Only the room owner can add members to a private room. Both the room owner and
members of the room can invite people to a public room.

To add new members to a chat room from the header

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Add members in the chat room header.
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3. Start typing the name of a contact you want to add to the chat room. As you type a
name, Bria Enterprise shows a list of suggestions. Select the person you want to
invite from the list. Repeat for all contacts you want to add to the room.

4. Click Add members to add the contacts. Click Cancel if you do not want to
add the contacts.

Bria Enterprise adds the contacts to the chat room.

Adding members from Settings

The owner of a private chat room can add additional members to a room from the room
settings.

To add new members to a room from chat room Settings

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Settings in the chat room header.

3. Start typing the name of a contact you want to add to the chat room in Add
recipients. As you type a name, Bria Enterprise shows a list of suggestions. Select
the person you want to invite from the list. Repeat for all contacts you want to add to
the room.
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4. Click Update.

Bria Enterprise adds the contact to the chat room.

Re-inviting a member

If the owner of the chat room sends an invitation to someone who is using a version of
Bria Enterprise that does not support chat rooms, the member may not automatically join
the chat room. Once they have upgraded their version of Bria Enterprise, the room owner
can re-invite the member.

To re-invite a member

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Members in the chat room header. The number indicates the number of
members in the room.

3. Right-click (Windows) or CTRL+click (Mac) on the member and click Resend
invitation.

The Member you re-invited is automatically added to the room.
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Removing a member

The owner of a private chat room can delete members from the room. This could occur if
the owner invites someone by mistake or if a person changes teams.

To remove a member from the Members list

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Members in the chat room header. The number indicates the number of
members in the room.

3. Right-click (Windows) or CTRL+click (Mac) on the member and click Remove
member.

The Member you removed is deleted from the room. The person sees a message that
they are no longer a member of the room.

To remove a member from Settings

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Settings in the chat room header.
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3. Click Remove beside the member. The persons name appears struck through.

4. Click Update.

The Member you removed is deleted from the room. The person sees a message that
they are no longer a member of the room.

Leaving or deleting a chat room
You can leave a private or public chat room without closing it if you are not the room
owner. You may be removed from a private chat room by the room owner. If you are the
room owner, you can delete a private or a public chat room.

Tip: Before you leave or delete a room, you may want to export the conversation.

Leaving a chat room

If you are not the room owner, you can leave a chat room from the Rooms list or from the
chat room header. If you have been removed from a private chat room by the room owner
and see You are no longer a member of this room., you can also leave the chat room.

To leave a room from the conversations list

1. Hover on the chat room in the All or Rooms tab.

2. Click Leave Room.

The chat room is removed from the Rooms list. If the chat room was private, you need to
be invited again to rejoin.
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To leave a room using the chat room shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on the chat room in the All or Rooms
tab.

2. Click Leave Room.

The chat room is removed from the Rooms list. If the chat room was private, you need to
be invited again to rejoin.

To leave a chat room using the room options

1. Click on the chat room in Rooms.

2. Click More options for this conversation.

3. Click Leave Room.

The chat room is removed from the Rooms list. If the chat room was private, you need to
be invited again to rejoin.

To leave a room from the messages

1. Click on the chat room in the All or Rooms tab.

2. Click Leave in the messages.
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The chat room is removed from the Rooms list. If the chat room was private, you need to
be invited again to rejoin.

Deleting a chat room

If you are a room owner, you can delete both public and private chat rooms. If you delete
the room, it is no longer available for other room members.

To delete a room from the Rooms list

1. Hover on the chat room in Rooms.

2. Click Delete Room.
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3. Click Yes (Windows) or OK (Mac).

The chat room is deleted and removed from the Rooms list.

To delete a room using the chat room shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on the chat room in Rooms.

2. Click Delete Room.

3. Click Yes (Windows) or OK (Mac).

The chat room is deleted and removed from the Rooms list.
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To delete a chat room using the room options

1. Click on the chat room in Rooms.

2. Click More options for this conversation.

3. Click Delete Room.

4. Click Yes (Windows) or OK (Mac).

The chat room is deleted and removed from the Rooms list.

The room owner removes you from a chat room

The room owner can remove you from a private chat room. If this happens, the chat room
remains in Rooms but is dimmed and shows a message that you are no longer a member
of the room and shows Room not available in Compose Message.
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To remove the chat room from Rooms, leave the room using one of the methods above.
In addition to the above methods, you can leave from the chat room messages panel. If
you want to keep the message history, export the conversation before you leave the
room.

To leave a chat room you have been removed from

1. Click on the chat room in Rooms.

2. Click Leave in the messages.

The chat room is deleted and removed from the Rooms list.

The room owner deletes a chat room

The room owner may delete a chat room that you are a member of. If this happens, the
chat room remains in Rooms but is dimmed and shows a message that the room is
closed and shows The Chat Room is not available in Compose Message.
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To remove the chat room from Rooms, leave the room using one of the methods above.
In addition to the above methods, you can leave from the chat room messages panel. If
you want to keep the message history, export the conversation before you leave the
room.

To leave a closed chat room

1. Click on the chat room in Rooms.

2. Click Leave in the messages.

The chat room is deleted and removed from the Rooms list.

Working with messages
Using Bria Enterprise, you can preview hyperlinks, search, copy/paste messages and
export conversations.

Searching messages
You can use the search feature to find a message in an IM or group chat using a Room
Name, name or a keyword.

To search in messages

1. Type the Room Name, contact's name or search keywords in the Search
Messages field. Bria Enterprise filters the sessions that contain the search words.
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Bria Enterprise displays the chat room and IMs that contain the search word.

2. Click the chat room or the IM that you want to view.

Bria Enterprise displays the messages in the chat room or IM that contain the name or
keyword. When you have scrolled through all of the messages containing the search
keywords in a chat room, you see No more messages.

Clear Search Messages to see all of the messages in the chat room or IM.

Copying and pasting messages
You can copy messages from Bria Enterprise and paste within the Bria Enterprise or in
another application.

To copy and paste messages

1. In the Messages window, highlight the message or messages that you want to
copy.

2. Windows: Right-click one of the selected messages and click Copy or press
CTRL+C on the keyboard.

Mac: COMMAND+ click on one of the selected messages and click Copy or press
COMMAND+C on the keyboard.
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Bria Enterprise places the messages on the clipboard. You can paste the messages in
Bria Enterprise or in another app on your computer. Formatting from the original message
is not retained.

Previewing hyperlinks
When you send or receive a message with a hyperlink in it, Bria Enterprise can show a
preview of the hyperlink in the message.

To control hyperlink previews

1. Click Preferences on the Softphone menu (Windows) or theBria Enterprise menu
(Mac).

2. Select or clear Show hyperlink preview on messages.

Bria Enterprise either shows or removes previews for all the hyperlinks in Messages.

Exporting messages
You can export instant messages and chat room messages into a .csv file.

Tip: When you close or leave a chat room, you no longer have the conversation history. If you
want to keep the messages, export them first.

To export a conversation using the More menu

1. Click on the message you want to export.

2. Click More options for this contact (Windows) or More options for this
conversation(Windows and Mac).
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3. Click Export Conversation.

Bria Enterprise opens the File Manager.

4. Select the location and enter a name for the file. Click Save.

Bria Enterprise saves the session as a .csv file in the location you selected. Formatting
from the original message is not retained.
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To export a conversation using the shortcut menu

1. Right-click on the IM or chat room and click Export Conversation.

Bria Enterprise opens the File Manager.

2. Select the location and enter a name for the file. Click Save.

Bria Enterprise saves the session as a .csv file in the location you selected. Formatting
from the original message is not retained.
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Presence

Changing your status
Bria Enterprise allows you to share your online status (your presence) with contacts who
have a softphone number or an XMPP address. When you launch Bria Enterprise, your
online status is Available.

You can change your status from Available to Busy, Away, Not available for call, Do not
disturb, and Appear offline. When you change your status from Available, Bria
Enterprise no longer automatically updates your status and it remains as what you set it
to until you change it again.

Bria Enterprise updates your status to On the phone when you make or receive a phone
call if your status is Available. If you do not use your computer for a specified period of
time (set in Preferences: Application panel), Bria Enterprise updates your status to Idle.

Note: To make use of presence on a SIP account, make sure that your VoIP provider
supports SIP SIMPLE.
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To change your status

1. Click the drop-down arrow beside your online status indicator.

2. Select the status you want to display.

Bria Enterprise updates your status. If you change your status away from Available, Bria
Enterprise does not automatically update your presence.

Status indicators and what they mean

Icon Status Meaning for your status Meaning for others’ status

Available Either:

l You have set your status to this value.

l Bria Enterprise has determined that you are logged on
but not on the phone or idle.

When you have this status, Bria Enterprise automatically
detects when you are idle or on the phone, and changes the
status to match.

You can contact this person.

Busy You have set your status to this value. Bria Enterprise never
automatically switches you out of this status; you must switch
yourself.

You can contact this person.

Away You have set your status to this value. Bria Enterprise never
automatically switches you out of this status; you must switch
yourself.

You can contact this person.

On the
phone

Either:

l You have set your status to this value. In this case,

You can contact this person.
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Bria Enterprise never automatically switches you out
of this status; you must switch yourself.

l You started a phone call when your status was
Available. When your call ends, your status reverts
back to Available.

Do not
disturb

You have set your status to this value. Bria Enterprise never
automatically switches you out of this status; you must switch
yourself.

You cannot contact this person.

Not
available
for calls

You have set your status to this value. Bria Enterprise never
automatically switches you out of this status; you must switch
yourself.

You cannot contact this person.

Idle You have not moved or clicked the mouse or pressed a
keyboard key for the idle period. Set the idle period in
Preferences: Application panel.

As soon as you click the mouse or keyboard, your status
changes to Available.

You can contact this person.

Appear
offline

You have set your status to this value. The other person sees
you as offline, even though you are actually online. The other
person cannot tell the difference between this status and you
really being offline.

You see the status Offline for this
contact. You cannot tell the difference
between this status and if the contact
is really offline.

Offline This status if automatically set by Bria Enterprise when you are
not signed in.

The contact is either not logged in or
does not want to share online status.

n/a No icon Not applicable You are not watching the other
person’s status.

Setting your custom status
You can create a custom wording for your presence status. When you set a custom
status, Bria Enterprise does not automatically update your status for you.

To change your custom status

1. Click on the wording in the status indicator and type your custom status. Press
ENTER when you finished.

Bria Enterprise updates your custom status.
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To remove your custom status

1. Click on the wording in the status indicator, delete all text, and press ENTER.

Bria Enterprise returns to the default status wording.

Viewing others’ status and status alerts
You can view the status of contacts who have a softphone number or an XMPP address
if they choose to share their status with you.

To view the status of your contacts, contacts must be tagged for presence. The way to tag
a contact for presence depends on the way they were added to contacts.

Requirements for viewing presence

In order for a contact to show a presence icon, they must be presence ready — they must
have an address that allows for presence data to be shared — and you must be
subscribed to the contact.

To make use of presence on a SIP account, make sure that your VoIP provider supports
SIP SIMPLE.

Account
type

How to set up for Presence

A contact is “presence ready” if:

Troubleshooting

If the contact is “presence ready” and the presence icon still
does not show:

SIP The contact has an address in the Softphone field.

If SIP addresses are not appearing in the Softphone field
after importing a file, the easiest solution is to fix the file and
redo the import.

Go to Softphone > Account Settings, select your SIP
account, and click Edit. Make sure that Allow this account
for IM / Presence is selected.

XMPP The contact has a Jabber address in the Instant Message
field.

Make sure the XMPP account is enabled.

Make sure you selected Enable Presence in the IM
introduction.

Outlook Your Outlook account has the Field to use for Softphone
address set to the field you are using for softphones in your
Outlook contacts.

Bria Enterprise recognizes the Outlook contact field as
containing a SIP address: an address that can be used for a
phone call, an IM, and presence via a SIP account.

Go to Softphone > Account Settings, select your SIP
account, and click Edit. Make sure that Allow this account
for IM / Presence is selected.

Go to Softphone > Account Settings, select your Outlook
account, and click Edit. Make sure Field to use for
Softphone address is set to the correct Outlook field.
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If you create contacts by importing a contact list, you can specify whether you want to see
presence during the import.

To enable presence of contacts you added manually using Contact Profile

To view the status of your contact when you added them manually in the Contact Profile
(Windows) or the Contact Editor (Mac), you need to include the method for viewing their
presence in their contact profile.

l If the contact is using SIP for presence, you need to add their SIP address to the
Softphone field. Bria Enterprise automatically obtains the status information for this
address.

l If the contact is using XMPP for presence, you need to add their XMPP/Jabber
address to the Instant Message field. The contact is sent a presence request. You
only see their status if they accept your request.

To enable contact presence in your XMPP account

1. On the Contacts panel, select the contact and click Edit.

2. Do one of the following to display a prompt.
l If there is no Instant Message information for the contact, enter a Jabber
address to the Instant Message field, and click Add.

l Click Enable XMPP Presence.

3. Click the check box to enable presence. Bria Enterprise sends a request to the
contact. If the person allows this request, their status appears in contacts.
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To enable presence for Windows Outlook account contacts

If you created an Outlook account on Bria Enterprise, you need to set up mapping to view
presence for your Outlook contacts.

1. Click Account Settings on the Softphone menu.

2. Select your Outlook account and click Edit.

3. In Account Details, set Field to use for Softphone address to the field you use in
Outlook to enter SIP addresses.

To enable presence for Mac Address Book account contacts

A Mac Address Book account is automatically created in Bria Enterprise. You can enable
or disable the Mac Address Book by selecting or clearing the check box in the Enabled
column.

If your Mac address book contains phone numbers that you know you can use to obtain
online availability information about a contact through your SIP account, you can
subscribe to their status in Bria Enterprise.

To respond to an online status request

Someone who is not one of your contacts may add you as a contact on their end. If they
include your softphone number or your XMPP address, you will receive an Online Status
Request.
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You can respond to the request by clicking Allow or Ignore.

Allow: The person is added to the List of contacts. You can edit the Display
as field and the Group for this person. Once you click Allow, Bria Enterprise
automatically sends a request back to the person.

Ignore: The other person will not be able to see your online status. The
Online Status Request may appear again in this session or a future session.

Online status alerts
You can add and remove contacts, favorites, or group of contacts to the alert list. When a
contact is on the alert list, you receive a Bria Enterprise notification when their online
status has changed.

To add contacts or favorites to the alert list

1. Click on a contact or favorite, or use SHIFT+Click, CTRL+Click (Windows),
COMMAND+Click (Mac) or a combination to select one or more contacts or favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add to Alert List (Windows)
or Add Contact to Alert List (Mac).

An alert icon appears by the contact after you add them to the alert list. The icon
disappears when you remove the contact from the alert list.
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To add groups to the alert list

1. Click on a group or use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more groups.

2. Right-click (Windows) or CTRL+click (Mac) and select Add Group to Alert List
(Windows) or Add Contacts in Group to Alert List (Mac).

Bria Enterprise adds the contacts in the group to the alert list. An alert icon appears by the
contacts in the group.

To remove contacts or favorites from the alert list

1. Click on a contact or favorite, or use SHIFT+Click, CTRL+Click (Windows),
COMMAND+Click (Mac) or a combination to select one or more contacts or favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove from Alert List
(Windows) or Remove Contact from Alert List (Mac).

Bria Enterprise removes the contacts or favorites from the alert list. The alert icon
disappears from the contacts.

To remove groups from the alert list

1. Click on a group or use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more groups.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove Group from Alert
List (Windows) or Remove Contacts in Group from Alert List (Mac)

Bria Enterprise removes the groups from the alert list. The alert icon disappears from the
contacts.
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Alert styles

Windows

You will receive a notification when the contact changes their status. On Windows 7
alerts, select Keep contact on Alert List if you want to continue to see presence changes.
On Windows 10 toast notifications, click Remove Alert to stop seeing presence changes
for the contact. You can call or IM the contact directly from both alert styles.

Mac

Banner style notifications appear briefly in the top corner of the screen. They will
disappear on their own. Alert styles notifications appear and remain on the screen until
you take action on them. Click the notification to bring Bria Enterprise into the foreground.
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Screen share

The Screen Share Add-in lets you share your screen with both Bria Enterprise users and
non-Bria Enterprise users. Your system administrator must enable screen share for you
in order to host a screen share session. You do not need to have screen share enabled to
view someone else's screen.

Hosting a screen share session
The screen share sessions do not contain audio so you will likely need an audio call as
well as the screen share session for a complete experience.

You can start a screen share session immediately, or send out a screen share link
beforehand as described below. Anyone with your screen share link can join the session.

To send out a screen share link to participants

1. Click Start sharing your screen on the onscreen phone.

2. Select Copy Screen Share link to clipboard.

3. Paste the screen share link into any communication client and send it to invitees.

The link is sent to invitees using your chosen communication client. The screen share
does not start automatically. Start sharing your screen any time when you are ready.
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Joining a screen share session
If you are a Bria Enterprise user, you might receive an invitation to join a screen share
from another Bria Enterprise user who has screen share enabled. You do not need to
have the add-in to receive the invitation.

To respond to a screen share invitation

l Click Join. The host’s screen appears.

l Windows: Type CTRL+SHIFT+ALT+S to bring the screen share window in front and
in focus if it moves behind other screens. Shortcut keys must be enabled in
Softphone > Preferences > Shortcut Keys.

l Close the screen share window to leave the session.
l Click Join in the IM to rejoin the session while it is still in progress.

Start screen share
You can start sharing your screen in various ways. Some of the ways described below
send an IM to participants when you start screen share, which works as a reminder for
people to join now.

Screen share does not contain audio. You can start and end screen share anytime
without affecting the audio call.

During the screen share session, the screen that you are sharing displays a red bounding
box around it. For an optimal viewing experience, Bria Enterprise may temporarily
change the background color of the shared screen for the duration of the session.
Nothing is changed in the settings and the color returns to your default at the end of the
screen sharing session.
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Before you start
l If you want to use multiple monitors during screen sharing, connect the additional
monitors before starting the screen share.

l Bria Enterprise shares your full screen or an application of your choice. Make sure
you close any apps that contain confidential information if you are planning to share
your entire monitor.

l When using macOS 10.15 Catalina, Bria Enterprise needs a permission for Screen
Recording in order to share your screen. Allow Bria Enterprise the permission if a
pop-up appears or by going to Mac's System Preferences > Security & Privacy >
Privacy.

Starting a screen share session from the on screen phone
This method does not send an IM; it simply starts sharing your screen. You can then add
more people during a session.

To start a screen share from the on screen phone

1. Click Start sharing your screen in the on screen softphone.

2. Click Share screen.

3. Choose a monitor or application to share, and click Start Sharing. To choose an
application, click the Windows tab and make sure the application you want to share
is launched and not minimized to the task bar.
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Bria Enterprise starts your screen share. The Screen Share panel appears on the
softphone showing you are sharing your screen.

Starting a screen share session from Contacts or Favorites
This method sends an IM and starts screen share. You can select multiple contacts or a
contact group. The contacts do not have to be Bria Enterprise users but they must have a
SIP or an XMPP address that you can send an IM to.

To send an invitation from Contacts and Favorites

1. On the Contacts or Favorites panel, click a contact, group, or favorite. To select
multiple entries, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac).

2. Right-click (Windows) or CTRL+click (Mac) or SHIFT+CTRL+click (Mac), and
choose Share Screen.

3. Choose a monitor or application to share, and click Start Sharing. To choose an
application, click the Windows tab and make sure the application you want to share
is launched and not minimized to the task bar.
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Bria Enterprise starts your screen share. The Screen Share panel appears on the
softphone showing you are sharing your screen. The contacts, favorites, or groups that
you invite receive an IM with your screen share link. They can click on the link to join.

Starting a screen share from the Messages window
This method sends an IM and starts screen share. Using a chat room is a good way to
invite a large group.

To send an invitation from the Messages window

1. In the Messages window, click on an IM or a chat room.

2. Click Share Screen in the IM or chat room header.

3. Choose a monitor or application to share, and click Start Sharing. To choose an
application, click the Windows tab and make sure the application you want to share
is launched and not minimized to the task bar.
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Bria Enterprise starts your screen share. The Screen Share panel appears on the
softphone showing you are sharing your screen. Everyone in the conversation receives
an IM with your screen share link. They can click on the link to join.

What's next
Read Managing a screen share session for handling an active screen share session.

Managing a screen share session
Handling an active screen share session
Once you start sharing your screen, Bria Enterprise shows the screen share panel below.

From this panel, you can temporarily pause screen share, switch the screen to share,
invite more people and end screen share.

To temporarily pause screen sharing

You can stop sharing your screen without ending the screen share session.

1. Click Pause Screen Sharing.

Bria Enterprise stops sharing your screen until your resume or end the screen share
session.

When screen share is paused or stopped, there is no page displayed to the viewers; the
last video frame is shown instead, as HD screenshare uses a video feed.
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To resume sharing your screen

1. Click Resume Screen Sharing.

Bria Enterprise starts sharing your screen again.

To switch the screen to share

You can switch what to share during an active screen share. The screen that you are
sharing displays a red bounding box around it.

1. Click Show Screen-share window. The window opens.

2. Choose a monitor or application to share, and click Start Sharing. To choose an
application, click the Windows tab and make sure the application you want to share
is launched and not minimized to the task bar.

To invite more participants

During an active screen share, you can invite more people to join your session by using
Participants +, or by copying the link and sending it to the invitee with any
communication tool.

When using Participants +, an invite is sent as an IM. The contacts you add to the screen
share session do not have to be Bria Enterprise users but they must have a SIP or an
XMPP address that you can send an IM to.
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1. Click Show Screen-share window. The window opens.

2. Click Participants + on the right.

3. Type the name of a contact you want to invite.

4. Click the contact from the contact list.

5. Repeat the process for all contacts you want to invite.

Bria Enterprise sends IMs to the contacts you selected. The contacts can click on the link
in the IM to join the screen share.

Tip: Alternatively, you can send a copied link using an email or any communication tool to
anyone. To copy your screen share link, click Share Link and select Copy Screen Share
link to clipboard.

To end screen share

1. Click Stop screen sharing.

Bria Enterprise stops sharing your screen.

When screen share is paused or stopped, there is no page displayed to the viewers;
the last video frame is shown instead, as HD screenshare uses a video feed.

Screen share icons

The following icons appear in the screen share toolbar:

Pause Screen Sharing: Temporarily stops sharing your screen without ending the
screen share session.
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Resume Screen Sharing: Starts sharing you screen after you have paused it during
the screen share session.

Show Screen-share window: Opens the Screen Share Options window. From here.
you can select a screen to share, invite people to view your screen, see who has been
invited but not joined yet, and copy the screen share link to the clipboard.

Stop screen sharing: End the screen sharing session.

Managing your screen share link
The screen share link is unique to you. The same link will be used until you generate a
new link. This allows you to send the link for recurring sessions.

Sometimes you will want to share your screen with a person one time — a customer in
another organization — and you may not want them to be able to join in future sessions. In
this case, you can generate a new link when you end your one-time session or before you
send out your next invitation.

To generate a new screen share link

1. Click Start sharing your screen in the on screen softphone.

2. Click Generate a new screen share link.

Bria Enterprise creates a new link. The old link no longer lets people view your
screen share.
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To copy the current screen share link

1. Click Start sharing your screen in the on screen softphone.

2. Click Copy Screen Share link to clipboard.

3. Paste the link to an application of your choice, such as email or calendar invite.
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Collaboration (Virtual Meeting Rooms)

Collaboration, also known as Virtual Meeting Rooms, is a cloud-based service hosted by
CounterPath that combines audio, HD video, screen sharing, messaging, and presence
in one virtual meeting.

As long as your subscription includes Collaboration, you can host a collaboration
conference using the Bria Enterprise client on desktop and mobile devices.

Anyone can join your collaboration conference using desktop and mobile devices. They
have a choice to use the Bria Enterprise app, use a browser, or dial in.

Hosting a collaboration conference
l Make sure to use a desktop device if you want to share your screen.
l It is a good idea to set a participant PIN for your conference for improved security.

Step 1: Set a PIN to join your conference

1. Click Softphone > Preferences (Windows) or Bria Enterprise > Preferences
(Mac).

2. Choose the Conferences panel, then enable Require PIN/Passcode and enter a
number.

Step 2: Invite people to your conference

1. Click Start or schedule a conference on Bria Enterprise.

2. Click Schedule a conference….
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3. Add invitees, and set time.

The PIN you set earlier appears in the invitation.

4. Send the invitation.

Tip: Alternatively, you can click Copy Conference Link to Clipboard and send the
link in the way you prefer. Don't forget to include the PIN to join your conference.

Step 3: Start a conference

1. If you are planning to share your screen, make sure you close any applications that
contain confidential information.

2. Click Start or schedule a conference on Bria Enterprise.

3. Click Start a Conference Now.

The conference console opens., and your conference is now in progress.

4. When you are ready to share your screen, click Start sharing your screen in the
conference console.

5. Choose a monitor or application to share, and click Start Sharing. To choose an
application, click the Windows tab and make sure the application you want to share
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is launched and not minimized to the task bar.

Participants see your screen. A red bounding box outlines your screen as a visual
cue to show what is being shared.

For more details, see Collaboration User Guide.
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Contacts

Viewing contacts
Bria Enterprise stores your contacts for you. These contacts may be contacts you have
added using Bria Enterprise, they can be contacts that are synched with your Outlook , or
they can be XMPP contacts who share their presence with you.

Contacts are organized in groups in List of contacts (Windows) or Contacts (Mac) —
referred to as Contacts. The Contacts tab might be empty at start-up or you might see a
pre-defined contact group. Each contact is shown with presence information (if available)
and icons for single-click calling and messaging.

If the Contacts or Favorites tabs are not showing, click Show Contacts or Show
Favorites on the View menu.

Using Contacts and Favorites
In Contacts or Favorites, you can open the Contact Info flyout, or open the Contact
Profile (Windows) or the Contact Editor (Mac) for more contact details.

Using the Contact Info flyout

1. Click on a contact in Contacts or Favorites. A Contact Info flyout appears with
contact information.

2. Click Profile if you want to see more information.
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Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor (Mac).

Using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a contact in Contacts or Favorites
and select Edit Profile (Windows) or View/Edit Profile (Mac).

Bria Enterprise displays the Contact Profile.

Using History
In History, you can open the Contact Info flyout to view contact information. Open the
Contact Profile (Windows) or the Contact Editor (Mac) for more contact details.
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Using the Contact Info flyout

1. Click on a History group to expand the group entry.

2. Click on Contact Info. A Contact Info flyout appears with contact information.

3. Click Profile if you want to see more information.

Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor (Mac).

Using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Edit Contact (Windows) or Edit Contact Profile (Mac).

Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor (Mac).
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Using Messages
You can view contact information from the Messages window.

IM

Using the shortcut menu

1. With the All or People filter applied, click on the IM in the conversation list.

2. Click Edit Profile (Windows) or View/Edit Profile (Mac).

Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor (Mac).

Using the More menu

1. With the All or People filter applied, click on the IM in the conversation list.

2. Click More options for this contact (Windows) or More options for this
conversation (Mac) in the conversation header.

3. Click Edit Profile (Windows) and View/Edit Profile (Mac).

Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor (Mac).
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Chat rooms

Using the Contact Info flyout

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Members in the chat room header. The number indicates the number of
members in the room.

The members list opens in the chat room panel.

3. Click on the contact's avatar.

The Contact Info flyout opens.

4. Click Profile to see more information.

Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor (Mac).

Adding and exporting contacts
For each contact you communicate with, you can save their information as an entry in the
contacts list. These contacts are added individually or by importing multiple contacts from
another source. You can also export your contacts to a .csv file, a vCard file, or a .pst file.

When you first install Bria Enterprise, and at any time in the future, you may want to
populate the contacts from an external source such as a file of contacts in your Outlook
address book.
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You can populate the contacts in these ways:

By entering contact information

By importing contacts

From an XMPP account

By adding your G-Suite account

By adding your Microsoft Outlook account

By adding your Mac Address Book account

Adding an individual contact
You can add contacts individually in the Contacts panel, using the Contacts menu and in
the History panel. For information on populating contacts, see Adding and exporting
contacts.

Adding a contact in the Contacts panel

Use Add a new contact or the shortcut menu to add an individual contact from the
Contacts panel.

To add a contact using the Add a new contact icon

1. On the Contacts panel, click Add a new contact.

The Contact Profile (Windows) or the Contact Editor (Mac) window appears.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.
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3. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send an
introduction to the contact. Type an introduction, if desired. If you do not want to see
the presence status for this person, clear Enable presence. When you are finished
click Continue.

4. Complete the Display name (required on Windows).

5. Complete any other fields you want to include with the contact.

6. Click OK.

The contact is added to Bria Enterprise.
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To add a contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a group and click Add Contact to
Group. The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send an
introduction to the contact. Type an introduction, if desired. If you do not want to see
the presence status for this person, clear Enable presence. When you are finished
click Continue.

3. Complete the Display name (required on Windows).

4. Complete any other fields you want to include with the contact.

5. Click OK.
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The contact is added to Bria Enterprise.

Adding a contact using the Contacts menu

You can add contacts to Bria Enterprise using the Contacts menu on the menu bar.

To add a contact using the Contacts menu

1. Click Add Contact on the Contacts menu.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.

When you use the Instant Message contact method, a window will open to send an
introduction to the contact. Type an introduction, if desired. If you do not want to see
the presence status for this person, clear Enable presence. When you are finished
click Continue.

3. Complete the Display name (required on Windows).

4. Complete any other fields you want to include with the contact.

5. Click OK.

The contact is added to Bria Enterprise.
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Adding a contact in the History panel

Add an unknown number to a new or existing contact from History.

To add a contact using Add this person to your contact list

1. Click on a History group with the caller ID Unknown. The History group expands.

2. Click Add this person to your contact list.

The Contact Profile (Windows) or the Contact Editor (Mac) opens.

3. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.

4. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send an
introduction to the contact. Type an introduction, if desired. If you do not want to see
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the presence status for this person, clear Enable presence. When you are finished
click Continue.

5. Complete the Display name (required on Windows) and any other fields you want
to include with the contact.

6. Click OK.

The contact is added to Bria Enterprise.

To add a contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on the History entry with the caller ID
Unknown and click Create Contacts.

The Contact Profile (Windows) or the Contact Editor (Mac) opens.

2. Use the Group drop-down arrow to select the group or groups that you want a
contact to belong to.

CounterPath an Alianza Company 154

Bria Enterprise User Guide Contacts



3. Use the drop down list to select the type of information you want to add, type the
information, and click Add (Windows) or the Add number icon (Mac).

When you use the Instant Message contact method, a window will open to send an
introduction to the contact. Type an introduction, if desired. If you do not want to see
the presence status for this person, clear Enable presence. When you are finished
click Continue.

4. Complete the Display name(required on Windows) and any other fields you want to
include with the contact.

5. Click OK.

The contact is added to Bria Enterprise.
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Adding a new number to an existing contact in the History panel

Add an unknown number to an existing contact from the History panel using the shortcut
menu. This method does not create a new contact; it just edits an existing contact to add
the new number you see in the History panel.

To add a new number to an existing contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on the History entry with the caller ID
Unknown and click Update Existing.

The Find Contacts dialog opens.

2. Choose a contact you want to add this number to.

The Contact Profile (Windows) or the Contact Editor (Mac) opens.

3. Edit any of the fields that need to be changed.

4. Click OK.

The number is added to the contact in Bria Enterprise.

Fields in Contact Profile

The Contact Profile is divided into Contact Summary, Contact, and XMPP. The XMPP
section does not show until you add the XMPP account to the Instant Message contact
information type. If you have merged multiple contacts together, you may see more than
one Contact and XMPP section.

Some fields may be read-only depending on how the contact was added to Bria
Enterprise.

This following is a list of Bria Enterprise contact fields and their description:
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Contact summary

l Contact image: The image associated with the contact. If the contact has more
than one image, use the drop-down to choose the image that you want to use. You
can also use the drop-down to Change or Reset the image.

l Display as: This field only shows if there are more than one Display name is
available for this contact. If several display names are available, choose the one
that you want to show in the contact list.

l Group: Click the drop-down list and select each group the contact is going to belong
to. A contact must belong to one group and can belong to multiple groups. See
Managing groups for more information.

l Primary presence: This field is read-only unless a contact has both a softphone
and an XMPP address. If the contact has more than one softphone address that
supports presence, use the Presence field in the Contact section to choose which
address to use. Primary presence is used for:

l The presence icon on the contact list that shows the status for this address.
l The single-click and double-click actions for instant messaging.

You can still send IMs to this person at their other addresses by using right-click
(Windows) or CONTROL+Click (Mac) and choosing them from the shortcut menu.

l Primary Call (Mac): This field is read-only unless the contact has more than one
phone number. Primary Call is used with single-click calling and double-click
calling.

l Primary phone number (Windows): This field is ready-only unless the contact has
more than one phone number. The Primary phone number is used with single-click
calling and double-click calling.

Contact

Display name (required on Windows): The display name is the source of
information.

First name, Last name (Optional): A first name and a last name for the
contact.

Contact Methods: The drop-down list that contains the different methods of
contacts.
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Enter the person's IM address as follows:

l Choose Instant Message if you are using an XMPP account for
messaging and presence.

Presence: This field is automatically populated when you enter and address
in the Softphone or Instant Message contact method. It indicates that you
are sharing presence information using this address. The address is shown in
the list in the Primary presence field.

XMPP

The XMPP section appears for contacts that use XMPP for messaging. The information
may have been entered manually in the Contact section or may be pulled from an XMPP
roster. There may be contact methods other than Instant Message listed in the XMPP
section that come from the roster. Only the Display name is editable.

Display name: The display name is the source of information.

First name, Last name (Optional): A first name and a last name for the
contact.

Importing contacts
You can populate Bria Enterprise’s contacts by importing an external file or files. Your
system administrator may have placed a file on the server for you to import. You can also
import your own file or files. New contacts will be added to existing contacts.

You can import a contact list from:

l .csv file: A comma-separated value file. Use this method to import from a
Microsoft® Excel® file.

l vCard file (*.vcf file): A vCard is an electronic business card that is often attached to
an e-mail.

l .pst file: (Windows) A Microsoft Exchange® contact list (*.pst file).

l Mac Address Book: (Mac) A Mac contact list.

Note: If you add your Outlook account or Mac Address Book account, you do not need to
import your Windows or Mac contact lists.
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To prepare a .csv file in Excel for import

1. Remove any introductory text or headings from the to of the file. You can keep the
text at the end of the file as it will be ignored during import.

2. Insert a blank row as the first row. In the next row, insert the heading that Bria
Enterprise will use to interpret the meaning of each column. The columns can be in
any order. The key heading are:

l sip-address: Bria Enterprise recognizes a value in this column as a softphone
address and considers the address as one that can be phoned and one that
can be using for IM and presence (if SIP is being used for IM and presence).

l xmpp-address: Bria Enterprise recognizes a value in this column as a Jabber
(XMPP) address and will map this field to the Instant Message field for the
contact.

l display-name, given-name, and surname
l business_number
l presence_subscription: Complete this field in one of these ways:

If you only want to share presence information with some of your contacts, fill
in this column in the file. Enter "true" for contacts whose online presence you
want to see. Leave this column blank or enter "false" for others. During the
import, you will be able to choose to share presence with only the contacts
that have "true". Bria Enterprise will subscribe to the presence for "true"
contacts assuming that the user has a SIP account (if SIP is being used for IM
and presence).

If you want to share presence with all or with none of your contacts, ignore this
heading. During the import you will be able to choose whether to share will all
or none of your contacts.

For a complete list of headings, see Contact list headings.

3. Save the file as "*.csv".

The file is now ready for import.
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To import contacts from a .pst, .csv, or vCard file

1. On the Contacts menu, click Import Contacts.

2. Select the file type — Comma-separated values (*.csv file), vCard (*.vcf file), or
Outlook or Exchange server (Windows only) — and click Next.

3. Enter the location of the file and click Next.

4. Set the Contact Options and the Presence options for all imported contacts and
click Next.

Bria Enterprise imports the contacts that are in the file.

To import Mac address book contacts

1. On the Contacts menu, select Import Contacts.

2. Use the drop-down list to select Mac address book in the Import from field and
leave Location blank.
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3. Set the Contact Options and the Presence options for all imported contacts and
click Start import.

4. Select the individual contacts you want to import or select the check box for Select
all contacts.

5. Click Import.

Bria Enterprise imports the contacts that are in the file.

Exporting contacts
You can export Bria Enterprise contacts to a file on your computer.

Windows

In Windows, Bria Enterprise contacts can be exported as a .csv file, a vCard file, or a .pst
file.

To export a .csv file

1. On the Contacts menu, click Export Contacts.

2. Select Comma-separated value (*.csv file) from the drop-down list and click Next.

3. Click Browse.
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The Windows save dialog open.

4. Use the file explorer to find the location you want to save the file, give the file a
name and click Save.

5. Click Next on Export Contacts.

A new .csv file is created in the location you chose in the Export Contacts wizard.

l PST: For a PST export, the existing PST file is updated to include the entries from
Bria Enterprise. If Microsoft®Outlook® is open, the entries immediately appear in
the Outlook contacts.

All information in Bria Enterprise is exported to Microsoft Outlook. Only information
that can be displayed in Outlook appears in the Outlook Contacts window.
Typically, this means that all softphone addresses are exported (and stored in
custom fields) but not displayed in Outlook.

l vCard and CSV: A new file of the specified type is created in the location you chose
in the Export Contacts wizard.

To export a .vCard file

1. On the Contacts menu, click Export Contacts.

2. Select vCard (*.vcf file) from the drop-down list and click Next.

3. Click Browse. The Browse For Folder dialog opens.
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4. Use Browse For Folder to navigate to the location you want to save the file and
click OK.

5. Click Next on Export Contacts.

A new vCard file is created in the location you chose in the Export Contacts wizard.

To export a .pst file

1. On the Contacts menu, click Export Contacts.

2. Select Outlook or Exchange server from the drop-down list and click Next.

3. Click Browse.

The Windows save dialog open.

4. Use the file explorer to find the location you want to save the file, give the file a
name and click Save.

5. Use the drop down list to select a field to use in the .pst file for the softphone
address and the IM address.

6. Click Next.

The existing PST file is updated to include the entries from Bria Enterprise. If Microsoft®

Outlook® is open, the entries immediately appear in the Outlook contacts. Typically, this
means that all softphone addresses are exported (and stored in custom fields) but not
displayed in Outlook.
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Mac

In Mac, Bria Enterprise contacts can be exported as a .csv file or a vCard file.

To export a .csv file

1. On the Contacts menu, click Export Contacts.

2. Select Comma separated values (*.csv file) from the drop-down list.

3. Type a name for the file in Save as.

4. Use Browse to select the location you want to export the file to.

5. Click Export.

A new file of the specified type is created in the location you chose in the Export Contacts
wizard.

To export a vCard file

1. On the Contacts menu, click Export Contacts.

2. Select vCard (*.vcf file) from the drop-down list.

3. Use Browse to select the location you want to export the file to.

4. Click Export.

A new file of the specified type is created in the location you chose in the Export Contacts
wizard.
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Setting up a G-Suite account
Your G-Suite account can be used to integrate your G-Suite contacts in Bria Enterprise.
G-Suite contacts are read-only in Bria Enterprise.

Bria Enterprise supports one G-Suite account. The G-Suite account cannot be disabled.
If you no longer want your G-Suite contacts to be displayed in Bria Enterprise or you want
to add a different G-Suite account, delete the existing G-Suite account from Bria
Enterprise.

To add your G-Suite account

1. Click Softphone > Account Settings (Windows) or Preferences > Account
Settings on the menu bar (Mac). The Account Settings window (Windows) or the
Preferences window (Mac) opens.

2. Click Add and click Google Account. Your default web browser opens.

3. If you have more than one G-Suite account, select the account from the list. If the G-
Suite account is not listed, select Use another account. Sign in to the G-Suite
account you want to use with Bria Enterprise.

4. Click Allow to give Bria Enterprise permission to access your G-Suite account. You
can close the web browser when you receive the message Received verification
code. You may now close this window..
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5. Click Apply or OK in the Account Settings window.

Your G-Suite contacts now show in Bria Enterprise. G-Suite contacts show up in Google
groups. Google groups and contacts display Google.

To delete your G-Suite account

1. Click Softphone > Account Settings (Windows) or Preferences > Account
Settings (Mac). The Account Settings window opens.

2. Click on your G-Suite account and click Remove.

Your G-Suite account is no longer linked and your G-Suite contacts no longer appear in
Bria Enterprise.
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Google API page continues to open

If you experience an issue where the Google API page opens each time you restart or log
back in to Bria Enterprise, try deleting the Keychain Access entry for the Bria Enterprise
Google Contacts login. On your next login, the Google API page opens again. After you
allow Bria Enterprise access to your Google account, your password should store
correctly in Keychain Access and the problem should no longer occur. For information on
deleting Keychain Access, please visit the Keychain Access User Guide.

Setting up Windows Outlook accounts
You can enable your Outlook account to provide Bria Enterprise with access to the
contacts in your address book. When you integrate Outlook contacts using an Outlook
account, the contacts are continually synced with the contacts in Outlook. By mapping
contact addresses to fields in Bria Enterprise, you can make calls and send messages to
Outlook contacts from either Bria Enterprise or from within Outlook.

To add your Outlook account

1. On the Softphone menu, click Account Settings. The Account Settings window
opens.

2. Click Add and click Outlook Account. The Outlook Account window opens on the
Account tab.

3. If you are using SIP for presence, select the Outlook contact field that you use for
softphone addresses from Field to use for Softphone address.

4. If you have an XMPP account, select the Outlook contact field that you use for IM
addresses from Field to use for IM address.

5. Click OK.

Bria Enterprise creates the Outlook account.

Settings in the panel

Account
Protocol: Read only. Always specifies Outlook.
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Account Details

Field to use for Softphone address: If you are using SIP for presence, you can set up
Bria Enterprise to treat one of the contact fields in Outlook as a SIP address that can be
subscribed to.

If you select Business Telephone Number in this field, any values that are in
the Business Telephone Number field in Outlook are copied to the Softphone
field in Bria Enterprise and Bria Enterprise subscribes to the online status of that
contact through your SIP account. If an Outlook contact has “2766” in Outlook’s
Business Telephone Number field and your SIP account domain is
“domainA.com”, Bria Enterprise subscribes to “2766@domainA.com”.

Field to use for IM address: If you have an XMPP account, you can set up Bria
Enterprise to treat one of the contact fields in Outlooks as an XMPP address that can be
subscribed to.

If you select IM Address in this field, any values that are in the IM Address field
in Outlook are copied to the Instant Message field in Bria Enterprise and Bria
Enterprise subscribes to the online status of that contact through your XMPP
account. If an Outlook contact has “aphillips@acphone.com” in Outlook’s IM
Address and the domain of your XMPP account is acphone.com, Bria
Enterprise subscribes to “aphillips@acphone.com”.

Setting up Mac Address Book accounts
Bria Enterprise pulls the Mac Address Book contacts into Bria Enterprise’s contacts. You
can phone or IM them directly from Bria Enterprise.

Setting up Mac Address Book account

Setting up the Mac Address Book account in Bria Enterprise allows you to directly call or
IM the contacts in your Mac Address Book.
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To set up the Mac Address Book account

1. On the menu bar, click Bria Enterprise – Preferences. The Preferences window
opens.

2. Click on the Accounts tab.

3. Click + at the bottom to add an account.

4. Select Mac Address Book. Make sure to enable the account.

Bria Enterprise pulls in the contact with the specified number already set up as a
softphone address.

Using your Mac Address Book for presence

If your Mac Address Book contains phone numbers that you know can be used to obtain
online activity information about the person through your SIP account, you can perform
this additional step.

To set up for presence

1. In the Mac Address book make sure that the contact type is Phone and the label is
softphone (in lower case).

2. On the menu bar, click Bria Enterprise – Preferences. The Preferences window
opens.

3. Click on the Accounts tab.

4. Make sure your Mac Address Book account is enabled. Bria Enterprise pulls in the
contact with the specified number already set up as a softphone address.

5. Open the contact in Bria Enterprise and choose the specified phone number in the
Primary Presence field and click OK.

Bria Enterprise obtains the presence for this contact.
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Permissions

Bria Enterprise requires permission to use your Mac contacts on macOS Mojave and
higher. If you are having issues with your Mac Address Book, check to make sure Bria
Enterprise has access to your contacts.

To give macOS contacts permission to Bria Enterprise

1. Click to open the Apple menu and select System Preferences.

2. Click Security & Privacy and select the Privacy tab.

3. Find the Contacts category. Select Bria Enterprise to allow access.

Bria Enterprise's permissions are updated.

Editing a contact
You can update contact information, merge and split contacts, change the contact
groups, and delete contacts.

You cannot edit, merge and split, change contact groups, or delete G-Suite contacts.

Updating contact information
You can open the Contact Profile (Windows) or the Contact Editor (Mac) from Contacts,
Favorites, History, and Messages. Once in the Contact Profile (Windows) or the
Contact Editor (Mac), you can edit the contact.

Using Contacts and Favorites

In Contacts and Favorites, you can use the Contact Info flyout or the shortcut menu to
open the Contact Profile (Windows) or the Contact Editor (Mac) so you can edit
contacts.
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To edit a contact using the Contact Info flyout

1. Click on a contact and click Profile in the Contact Info flyout.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Edit any of the fields that need to be changed.

3. Click OK.

The contact is updated in Bria Enterprise. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.

To edit a contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a contact and select Edit Profile
(Windows) or View/Edit Profile (Mac).
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The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

2. Edit any of the fields that need to be changed.

3. Click OK.

The contact is updated in Bria Enterprise. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.

Using History

In History, you can use the Contact Info flyout or the shortcut menu to open the Contact
Profile (Windows) or the Contact Editor (Mac) so you can edit contacts.

CounterPath an Alianza Company 172

Bria Enterprise User Guide Contacts



To edit a contact using the Contact Info flyout

1. Click on a History group to expand the group entry.

2. Click on Contact Info. A Contact Info flyout appears with contact information.

3. Click Profile.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

4. Edit any of the fields that need to be changed.

5. Click OK.

The contact is updated in Bria Enterprise. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.
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To edit a contact using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Edit Contact.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

3. Edit any of the fields that need to be changed.

4. Click OK.

The contact is updated in Bria Enterprise. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.

Using Messages

In Messages, you can use the shortcut menu, the More menu, or the Contact Info flyout
to open the Contact Profile (Windows) or the Contact Editor (Mac) so you can edit your
contacts.
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IM

Using the shortcut menu

1. With the All or People filter applied, click on the IM in the conversation list.

2. Click Edit Profile (Windows) or View/Edit Profile (Mac).

Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor
(Mac).

3. Edit any of the fields that need to be changed.

4. Click OK.

The contact is updated in Bria Enterprise. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.
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Using the More menu

1. With the All or People filter applied, click on the IM in the conversation list.

2. Click More options for this contact (Windows) or More options for this
conversation (Mac) in the conversation header.

3. Click Edit Profile (Windows) and View/Edit Profile (Mac).

Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor
(Mac).

4. Edit any of the fields that need to be changed.

5. Click OK.

The contact is updated in Bria Enterprise. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.
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Chat rooms

Using the Contact Info flyout

1. With the All or Chat Room filter applied, click on the chat room in the conversation
list.

2. Click Members in the chat room header. The number indicates the number of
members in the room.

The members list opens in the chat room panel.

3. Click on the contact's avatar.

The Contact Info flyout opens.

4. Click Profile if you want to see more information.

Bria Enterprise displays the Contact Profile (Windows) or the Contact Editor
(Mac).

5. Edit any of the fields that need to be changed.

6. Click OK.

The contact is updated in Bria Enterprise. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.
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Merging contacts
If you have two entries that should be one contact, you can merge the contacts together.

To merge contacts using the shortcut menu

1. Use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac) or a combination
to select one or more contacts you want to merge.

2. Right-click (Windows) or SHIFT+CTRL+Click (Mac) and select Merge Contacts.

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.

3. Edit any of the fields that need to be changed.

4. Click OK.

The contacts are merged into a single contact. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.
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To merge contacts using drag and drop

1. Use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac) or a combination
to select all but one of the contacts you want to merge.

2. Drag the selected contacts onto the last contact you want to merge. The Merge
Contacts dialog opens.

The Merge Contacts dialog opens.

3. Click Yes on the Merge Contacts pop-up.

The Contact Profile (Windows) or the Contact Editor (Mac)window opens.

4. Edit any of the fields that need to be changed.

5. Click OK.

The contacts are merged into a single contact. If you add or edit the Softphone or Instant
Message contact method, an online status request is sent to this person.
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Splitting contacts
If you want to separate a merged contact back into separate contacts, you can split the
contact.

To split contacts using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a contact and click Split Contact.

Bria Enterprise splits that contact into the original contacts.

To split a contact using the Contact Profile

1. Right-click (Windows) or CTRL+click (Mac) on a contact and select Edit Profile
(Windows) or View/Edit Profile (Mac).
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The Contact Profile (Windows) or the Contact Editor (Mac) opens.

2. Click Split Contact.

The contact is splits into the original contacts.
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Changing contact groups
You can move a contact from one group to another or add them to multiple groups.

To move contacts to another group

1. In the contacts panel, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac) or a combination to select one or more contacts you want to move to another
group.

2. Drag the selected contacts to the title bar of the new group.

The contact or contacts are removed from the old group and added to the new group.

To add and remove contacts from multiple groups using the Contact Profile

1. Right-click (Windows) or CTRL+click (Mac) on a contact and select Edit Profile
(Windows) or View/Edit Profile (Mac).

The Contact Profile (Windows) or the Contact Editor (Mac) window opens.
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2. Click the drop-down arrow in Group. Select the groups you want to add the contact
to and deselect the groups you want to remove the contact from.

3. Click OK.

The contact is added to all groups you selected and removed from all groups you
deselected.

To remove a contact from a single group

If a contact is in multiple groups, you can remove them from one of the groups.

1. Use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac) or a combination
to select one or more contacts you want to remove from a group. Make sure you
select the contact or contacts in the group you want to delete them from.

2. Right-click (Windows) or CTRL+click (Mac) and click Delete Contact for an
individual contact or Delete Selected for multiple contacts.

3. If the contact belongs to more than one group, clear Delete this contact from all
groups or Delete these contacts from all groups. Click Yes in the Delete Contact
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dialog.

The contact or contacts are removed from the group. They remain in any other groups
they belonged to.

Deleting a contact
You can delete a single contact or a group of contacts from Bria Enterprise.

To delete one or more contacts

1. In the contact panel, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click
(Mac), or any combination to select the contacts you want to delete.

2. Right-click (Windows) or CTRL+click (Mac) and select Delete Contact or Delete
Selected.

3. If the contact belongs to more than one group, leave Delete this contact from all
groups or Delete these contacts from all groups selected. Click Yes.

The contacts are deleted.
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Managing groups
Contacts are arranged in groups. Bria Enterprise has three default groups: Family,
Friends, and Work.

Each contact must belong to at least one group and can belong to multiple groups. You
can create, rename, and delete groups.

As well as organizing your contacts, you can perform the following actions on groups
instead of on individual contacts:

Create a chat room

Screen share

Add a group to the alert list

Add a group to Favorites

Creating a group
Use the shortcut menu or the Contacts menu to create a new group.

To create a new group using the shortcut menu

1. Right-click (Windows) or CTRL+click (Mac) on a group in contacts from the shortcut
menu.

2. Type in a group name in the New Group window and click OK.
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The new Group is displayed in the List of contacts.

To create a new group using the Contacts menu

1. Click New Group on the Contacts menu.

2. Type in a group name in the New Group window and click OK.

The new Group is displayed in Contacts.
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Renaming a group

To rename a group using the shortcut menu

1. Right-click on a group in Contacts and select Rename Group.

2. Type in a the new group name in the Rename Group window and click OK.

The Group appears with the new name in the List of contacts.

Deleting groups

To delete a group

1. Right-click (Windows) or CTRL+click (Mac) on a group in contacts and select Delete
Group.

2. If there are contacts in the group, click Yes in Delete Group.
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The Group is deleted from contacts. Any contacts that were not in another group are
deleted.

Favorites
If you have contacts that you use frequently, you can add these contacts as Favorites for
easier access. You can create favorites from the Contacts panel or in the contact profile.
When you add a contact to Favorites, it displays in both the Contacts panel and the
Favorites panel. Adding contacts to Favorites makes it easier to find contacts that you
use frequently.

Adding a contact to Favorites
You can add a contact to Favorites using the shortcut menu.

To add a contact to Favorites

1. Click on a contact or SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac)
on one or more contacts you want to add to Favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add to Favorites.

The contact or contacts are added to Favorites.

Adding a group to Favorites
You can add a group to Favorites using the shortcut menu.
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To add a group to Favorites

1. Click on a contact, SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac)
one or more contacts you want to add to Favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Add Group to Favorites
(Windows) or Add Contacts in Group to Favorites (Mac).

The contacts in the group or groups appears are added to Favorites and can be viewed
in the Favorites panel.

Removing a contact from Favorites
You can remove a contact from Favorites panel using the shortcut menu.

To remove a contact from Favorites

1. On the Favorites panel, click on a contact, or SHIFT+Click, CTRL+Click (Windows),
COMMAND+Click (Mac) one or more contacts you want to remove from favorites.

2. Right-click (Windows) or CTRL+click (Mac) and select Remove from Favorites.
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The contact or contacts are removed from the Favorites panel but still appear in the
Contacts panel.

Warning: If you select Delete Contact, the contact is deleted from Bria Enterprise, not just
from Favorites.

Directory Tab
The Directory tab is only available if your system administrator has set up Bria Enterprise
to access a corporate directory. Only one phone number appears for each entry. More
numbers may show on the shortcut menu for the contact.

The Directory tab may be configured as on demand or may be populated with users as
soon as you sign in. If it is configured as on demand, the Directory tab is empty until the
user types in a search strings and click Search. If the Directory shows a list of users when
you sign in, you can type text into the search field, but there is no Search button.

To view the Directory tab, click Show Directory on the View menu.

To phone a directory contact

Right-click (Windows) or CTRL+click (Mac) on an entry and choose Call or Video Call
from the shortcut menu. If there is more than one number for the person, click on the
number that you want to use.

To create a contact from the directory

1. Right-click (Windows) or CTRL+click (Mac) on an entry and choose Add as
Contact. The Contact Profile (Windows) or Contact Editor (Mac) window appears
with all the information from the directory populated.

2. Complete any of the fields that are missing information you want to add to the
contact and click OK.

The person is added to contacts.

When a contact is created from the directory, the contact is:
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l Automatically updated whenever the corresponding directory entry changes.
l Automatically deleted if the corresponding directory entry is deleted.

Note: Contacts created from directory entries do not show presence when you are using SIP
SIMPLE for presence as opposed to XMPP and when contacts are created from an LDAP or
Active Directory. If you create the contacts manually in the contacts panel, presence will
display properly.

To delete a directory contact

A contact created from the directory can be deleted from Contacts.

1. In Contacts, use SHIFT+Click, CTRL+Click (Windows), COMMAND+Click (Mac), or
any combination to select the directory contacts you want to delete.

2. Right-click (Windows) or CTRL+click (Mac) and select Delete Contact or Delete
Selected.

3. If the contact belongs to more than one group, leave Delete this contact from all
groups or Delete these contacts from all groups selected. Click Yes.
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The person is deleted from Contacts. The person is not deleted from the Directory.
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History

Viewing History
All Bria Enterprise calls are captured in Bria Enterprise's List of recent calls (Windows)
or History (Mac) – referred to as History. Calls are grouped to easily find all calls from one
contact, and can be filtered to make it easier to find a specific call. The most recent 200
calls per SIP account are stored in Bria Enterprise.

Call grouping
Calls captured in Bria Enterprise's history are grouped by name and caller ID. The caller
ID can be a phone number or a SIP address, but will be referred to as phone number. The
group can be expanded and collapsed to show or hide the individual calls in the group.

If a person has called you from multiple numbers, you may see more than one group of
calls for them.

Collapsed group display

The collapsed group displays an overview of call information: the name and presence
status of the caller, the number and types of calls, and the time and date of the most
recent call.

Expanded group display

The expanded group shows a list of recent calls between you and the person. The most
recent calls are displayed at the top of the list. In addition to the information displayed in
the collapsed group, Bria Enterprise also shows whether the call was voice or video, the
time and date, and the length of the call.
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Multiple groups for the same number

In some cases, calls from the same person may show up in multiple groups. If one call
only contains the phone number, and another call contains the phone number with a
domain, they calls appear in two different groups. Bria Enterprise does not strip the
domain and try to match the results with other calls.

Multiple contacts with the same number

When you have a number that is used for multiple contacts, all calls for that number are
grouped together as Multiple Contacts. Expand the group and click Contact Info to
see the contacts associated with the number.

Unknown contacts

There are two types of unknown contacts that can appear in the call history. If a call
comes from a phone number that is not in your contacts, the contact is grouped as
Unknown with the phone number displayed. Calls that come in with an unknown number
are grouped as Unknown with Unknown displayed for the number.
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To view all calls in a group

1. Click the group you want to expand.

Bria Enterprise displays the expanded group.

Call type icons
Incoming call

Incoming call answered on another device - Appears when Call History Sync is
enabled for the account.

Outgoing call

Incoming call recorded on this device

Outgoing call recorded on this device

Blocked call - Appears when Call Blocking is enabled.

Missed call

Call History Sync
With Call History Sync, when a user enables their SIP account on multiple devices, the
user sees consistent call log history on all the devices. For example, a user answers a
call on a Windows computer, and sees on an iPhone that the call was answered on
another device.

Deleting an entry from Bria Enterprise's call log history results in deleting the entry
from all the devices.

Call History Sync can be configured for your Stretto group by your administrator.
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Searching and filtering History
To find a specific entry in History, you can filter or search the list of recent calls, or use
both methods.

Limit the calls you see in the call history using filtering. Bria Enterprise lets you filter all
calls, incoming calls, missed calls, calls that were answered elsewhere, Collaboration
conference calls, calls with recordings, and calls by date.

Searching History
Search for a call in History by either the name of the caller or by their phone number.

To search History

1. Type the name or phone number for the call your are looking for in Search History.

2. Expand the History entry to find specific call details.

Bria Enterprise displays all calls from the name or number.

Filtering History
Limit the calls you see in History using filtering.
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Available filters

l incoming calls (with second filter for Date)
l missed calls (with second filter for Date)
l answered elsewhere
l Collaboration conference call (with second filter for Date)
l Calls with recordings (with second filter for Conference or Call)
l Date

You can search Bria Enterprise for calls based on when the call occurred. Filter
calls from Today, Yesterday, This Week, This Month, Last 7 Days, and Last 30
Days. This Week filters for calls for the current week running from Sunday to
Saturday. This Month filters for calls during the current calendar month.

To apply a filter to the History

1. In History, click on the call filter and select the filter you want to apply.

2. Click the second filter if applicable.

Bria Enterprise displays the calls that match the filter(s).

Tip:
To see which filter is applied to call history when the full name of the filter does not fit,
hover over the filter drop down and the full text appears.
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Search and filter History
Use search and filter at the same time. You can filter your results first, and then enter your
search information or enter your search information first and filter your results.

Call recordings in History
Call recording are available in Bria Enterprise's List of recent calls (Windows) or History
(Mac) – referred to as History. You can play and delete recordings from History, in
addition to using the file explorer on your computer to play and delete recording files.

Filtering for recordings
If you are searching for a call recording, you can filter the History to show only calls that
have recordings.

To filter for recordings

1. Click on the call filter and click Recordings.

Bria Enterprise displays all calls that have a recording associated with them.

Multiple recordings

If you created multiple recordings of a call – you stopped and restarted a recording during
the same call – all the call recording are visible in the expanded view of the call entry.
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Playing back a call recording
You can play back a call recording using either History or using the file explorer on your
computer. This section describes how to play back a call recording using call history. For
more information on call recording, including using the file explorer to listen to a
recording, see Recording a call.

To play back a call recording

1. Optional: Click on the filter and select Recordings.

2. Click on the history group that contains the recording. The history group expands.

3. Click on the call entry that contains the recording. The call entry expands.
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4. Click Play Recording.

Bria Enterprise plays the recording in your default audio player.

Deleting a call recording
You can delete a call recording using History or by locating the file on your computer and
deleting it using file explorer. This section describes how to delete a call in History.

To delete a recording

1. Optional: Click on the filter and select Recordings.

2. Click on the history group that contains the recording. The history group expands.

3. Click on the call entry that contains the recording. The call entry expands.
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4. Click Delete Recording.

5. Click OK on Recording File.

Bria Enterprise deletes the recording from your computer and you can no longer play
back the file in call history.

The history entry still appears when the Recordings filter is applied. Delete Recording
and Play Recording are still visible in the call entry but are inactive.

Click Recording Info to see when the file was deleted.

Exporting calls from History
You can export your from Bria Enterprise's List of recent calls (Windows) or History
(Mac) – referred to as History – Bria Enterprise to a .csv file.

To export call history

1. Right-click (Windows) or CTRL+click (Mac) on any group in History and click Export
to File.

2. Use Browse For Folder to set the location where you want to save the file and click
OK.

Bria Enterprise exports the .csv file to the specified location.

Deleting History
Calls are grouped by caller ID in Bria Enterprise's List of recent calls (Windows) or
History (Mac) – referred to as History. You can delete all calls in History, or you can
delete all calls in a group.
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To delete all calls

1. Right-click (Windows) or CTRL+click (Mac) on a call group or the heading of an
expanded call group.

2. Click Delete All.

3. Click OK on Confirm Delete.

Bria Enterprise deletes all calls from History.

To delete a History group

1. Right-click (Windows) or CTRL+click (Mac) on the call group or the heading of the
expanded call group you want to delete.

2. Click Delete.

Bria Enterprise deletes the calls in the History group.
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Warning: There is no warning before all calls in a group are deleted.
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Microsoft Office Integration – Windows
only

Bria Enterprise is integrated with Microsoft Office 2013, Microsoft Office 2016, and
Microsoft Office 365. However, the Office 365 Web App (a browser-based version of
Microsoft Outlook) is not supported.

You can place an audio or a video call, send an IM, and see presence information directly
from Outlook’s mini-contact card. The mini-contact card appears anywhere you see a
contact — the email header, the Social Connector, the scheduler assistant, the people tab
— when you hover over that contact.

To enable Office integration – Windows only

1. Open Preferences on the Softphone menu.

2. Click Enable Outlook integration in the Application panel.

3. Restart Microsoft Outlook.

Bria Enterprise is available from Outlook.
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To disable Office integration – Windows only

1. Open Preferences on the Softphone menu.

2. Click Disable Outlook integration in the Application panel.

3. Restart Microsoft Outlook.

Bria Enterprise is no longer available from Outlook.

Placing an audio or video call from Outlook
You can place an audio or video call from the mini-contact card to an Outlook contact that
you have a phone number or softphone number for.

To place a call

1. Hover over a person’s name anywhere in Outlook. The mini-contact card appears.

2. Click on Call or Start video call.

Bria Enterprise places the call or video call and opens the call panel. If you clicked Start
video call, Bria Enterprise opens the Video window if the remote party answers the call
with video.

If a contact has more than one number, you can choose the number you want to call.

To place a call to a contact with multiple numbers

l Click the drop-down arrow beside Call or Start video call and select the
number that you want to call.
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Bria Enterprise places the call or video call and opens the call panel. If you clicked Start
video call, Bria Enterprise opens the Video window if the remote party answers the call
with video.

IM and presence in Outlook
The Outlook Integration offers you the ability to view presence information and send IMs
directly from Microsoft Office.

Sending an IM
There are two ways to send an IM from Outlook: clicking on IM in the message header
and clicking on Send an IM on the mini-contact card.

To send an IM from the message header

1. Click on Send an IM to send an IM to the email sender.

Bria Enterprise opens the Message window.

2. Type your message and click send.

Bria Enterprise sends the IM.

To send an IM from the mini-contact card

1. In the header or in the Social Connector, hover over a name or avatar. The mini-
contact card appears.

2. Click Send an IM.

3. If the contact has more than one address you can send an IM to, you can choose
the address you want to use. Click the drop-down arrow beside Send an IM.

CounterPath an Alianza Company 206

Bria Enterprise User Guide Microsoft Office Integration – Windows only



Bria Enterprise opens the Message window.

4. Type your message and click send.

Bria Enterprise sends the IM.

To view the online presence of contacts
You can view the online status — the presence — of contacts that have share presence
information with you in Bria Enterprise. Presence is shown in the mini-contact card,
beside avatars, and beside names in the email header.

l On the mini-contact card, presence is indicated by both a colored stripe on the side
of the avatar and by having the status in words under the contacts name.

l On the avatar, presence is indicated by a colored stripe.
l In the email header, a colored dot beside the name displays the status.

Mini-contact card Avatar Name Meaning

This person is Available and you can contact this person.

This person is Busy. You can contact this person.

This person is Away. You can contact this person.

This person is on a call. You can contact this person.

Appearance and Meaning of Presence in Microsoft Office
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Mini-contact card Avatar Name Meaning

This person has either set Do not disturb or has set Not
available for calls. You cannot contact this person.

This person has either set their status as Appear offline or they
are Offline. This contact is either not logged on or does not
want to share online status.
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BroadWorks Feature Pack

Bria Enterprise can be integrated with the BroadWorks platform if your system
administrator enables this feature. This section describes the features that are in the
BroadWorks-feature-enabled Bria Enterprise but not in regular Bria Enterprise.

BroadWorks Feature Pack is a set of BroadWorks features such as:

l Service management: Bria Enterprise allows users to change some of
BroadWorks services from within the client. Bria Enterprise syncs any change with
the BroadWorks Xtended Services Platform (XSP) server.

l Server-based directory (Enterprise Directory): Bria Enterprise retrieves server-
based enterprise directory and/or group directory from the XSP server and displays
it in a dedicated page.

l Server-based call history (Call Logs): Bria Enterprise downloads the call history
saved in the XSP server and displays it along with local call history in one single
tab.

When Bria Enterprise has BroadWorks Feature Pack enabled, you see the extra tabs or
menus as shown below.

Service management

Bria desktop has an extra page for BroadWorks under Preferences.

All the settings under the BroadWorks menu are synched with the XSP
server/BroadWorks web portal. If the user makes changes on the Service Management
settings on Bria Enterprise after login, Bria accesses the XSP server, and modifies the
settings on the XSP server. If a setting for a given service on the XSP server is changed
outside of Bria Enterprise (for example, by using the BroadWorks web portal), the user
can sync the information within Bria Enterprise by logging out and logging into Bria
Enterprise again. Or on Bria desktop, it retrieves the latest information from the XSP
server when the user opens the BroadWorks page under Bria Enterprise's Preferences.
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Server-based directory (Enterprise Directory)

Bria desktop shows an extra tab for Contact Directory along with the existing Contacts
and Favorites tabs.

Directory gives users access to the server-based directory where user can search, make
a call to an entry, and save an entry to local address book. Once saved locally, the
information on the entry does not sync with the information on the XSP server.

Tip: If the Directory tab is empty, enter a search keyword and perform search. The
entries that match the search will appear.

Server-based call history (Call Logs)

The existing History tab displays server-based call history stored on the BroadWorks
server as well as the local call history. The server-based call history syncs with the
BroadWorks server; meaning that users can delete an entry on the Bria Enterprise client,
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and it deletes the same entry from the XSP server as well. The server-based call history
does not persist on the device (the history will be erased from the device when user logs
out from the service on Bria Enterprise).

Bria Enterprise retrieves an enhanced history, and falls back to a basic history if
enhanced history is not available from the XSP server. End users are notified when this
occurs.
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Account settings

There are two ways of configuring Bria Enterprise – Account Settingsand Preferences.
Account Settings are settings that only apply to an individual account. Preferences are
settings that apply to Bria Enterprise as a whole.

This section describes Account Settings. Account Settings shows all of the accounts
currently set up. From this window, enable and disable your accounts. Click Softphone >
Account Settings (Windows) or Bria Enterprise > Preferences > Accounts (Mac) to view
Account Settings.

Selecting default accounts
If you have multiple SIP accounts, you can select your preferred SIP account from
Account Settings.

Your Outlook account (Windows) and your Mac Address Book account (Mac) are
configured in the Account Settings window. Your SIP and XMPP accounts are
configured by your system administrator.

To view the Account Settings – Windows

1. Click Account Settings on the Softphone menu.

The Account Settings window opens.
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To view the Account Settings - Mac

1. On the menu bar, click Preferences.

2. Click the Accounts tab.

The Preferences – Accounts window opens.

The Call column
The Call column shows how the account is used for calls.

Windows icons

: The account is the preferred account for calls

: The account can be used for outgoing calls if you select is when placing an outgoing
call

no icon: The account cannot be used for phone calls. It is either a SIP account with calling
disabled or a non-SIP account.

Mac icons

: The account is the preferred account for calls

: The account can be used for outgoing calls if you select is when placing an outgoing
call

: The account cannot be used for phone calls. It is either a SIP account with calling
disabled or a non-SIP account.

The Status column
The Status column indicates the registration status of each account.
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Windows Meaning

Ready: The account is registered and can be used for calls (SIP) and messaging.

Registering: The account is in the process of registering.

Failed: The account is enabled but registration failed. Check that you entered your
account credentials correctly.

Disabled: The account is disabled. Select the Enabled check box to register the account.

Mac Meaning

: The account is registered and can be used for calls (SIP) and messaging.

: The account is in the process of registering.

: The account is enabled but registration failed. Check that you entered your account
credentials correctly.

: The account is disabled. Select the Enabled check box to register the account.

Selecting your preferred account for calls
Preferred account for calls only appears when you have more than one SIP account.
The preferred account is used if there are no dial plan rules being used to determine the
outgoing account and you do not explicitly choose an account for the outgoing call.

To select your preferred account

1. Open the Account Settings window.

2. Select your preferred SIP account from Preferred account for call.

Your preferred account is set.

SIP account settings
A SIP account is used to make voice and video calls in Bria Enterprise. Each user
requires at least one SIP account. The SIP account can also be used for presence and
messaging if your VoIP service provide supports SIP SIMPLE.

This section describes the SIP account settings.
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Note: SIP account settings are read-only.

Accounts or General panel (SIP)

Note: These fields are view only.

The Accounts (Windows) or General (Mac) panel shows the User Details, Domain
Proxy, and the Dial plan for the account.

Settings in this panel

Account Name

Account Name: Used to identify the account. If desired, change the name to something
meaningful to you. For example, the name of your VoIP service provider.

Protocol: Read-only. Always specifies SIP.

Allow this account for

Calls (Windows) / Used for Call (Mac): Determines if the account is used to place
outbound calls.

Selected: This account can be used for outbound calls.

Cleared: This account cannot be used for outbound calls.

IM / Presence (Windows) / Presence (Mac): Determines if the account is used for
presence and messaging.

Selected: This account is used to share your online presence and send
instant messages.

Cleared: This account is not used to share your online presence and send
instant messages.

User Details

User ID: The account number for the softphone. Provided by your VoIP service provider.
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Domain: The domain of your softphone address. Provided by your VoIP server provider.

Password: The password for the softphone. Provided by your VoIP service provider.

Display name: This is the name that is displayed in the Bria Enterprise title bar. Remote
parties see this name.

Authorization name: Complete this field if your VoIP service provider gave you an
authorization name. Typically not used in an enterprise environment. An Authorization
name is useful if you allow user IDs that are short and easy to guess. The Authorization
name is used in place of the User ID to register the SIP account.

Domain Proxy

Register with domain and receive calls: This field must be Cleared if your level of
service does not include the ability to receive incoming calls. In this case, leaving this
field selected may prevent the account from registering.

Selected: Register this account with your VoIP service provider so you can
receive incoming calls.

Cleared: This SIP account cannot be used for incoming calls.

Send outbound via: Choose the settings specified by your VoIP service provider. If you
select this field, complete the Address field with the domain provided by your VoIP
service provider.

Domain: Select this field if your VoIP service provider requires that traffic be
directed to proxies that are discovered via the domain.

Proxy: Select this field if your VoIP service provider has an outbound proxy
address and requires that you provide the address to your softphone client.

If neither of these options are suitable, see Advanced for additional ways to direct traffic.

Dial Plan

Dial Plan: Information about the syntax of the numbers used by your VoIP service
provider. This information is provided by your VoIP service provider.

The default plan is: #1\a\a.T;match=1;prestrip=2;
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You do not have to change the dial plan if:

l You only have one SIP account.
l You have multiple SIP accounts but will always manually select the account to use
for calls.

l The default plan is acceptable.

See Using a Dial Plan to Modify How Calls are Placed for information on configuring dial
plans.

Voicemail panel (SIP)
This panel shows your set up for client-side voicemail and client-side call forwarding.

Note: These fields are view only.

Voicemail is offered through your VoIP service provider or through your enterprise’s IP
PBX. It is not part of Bria Enterprise. Contact your VoIP service provider or your system
administrator for information on using voicemail.

Settings in this panel:

Voicemail

Check for voicemail: Check with your VoIP service provider or your enterprise’s IP PBX
system administrator for the correct configuration.

Selected: Subscribe for message waiting — Bria Enterprise must subscribe to
be notified when there is a voicemail.

Cleared: Implicit subscription — the VoIP service provider’s voicemail server
send notifications without Bria Enterprise subscribing.

Cleared: Your VoIP service provider does not support voicemail.

Number to dial for checking voicemail: Complete this field only if your VoIP service
includes voicemail. This is the number that will be called when a user click the Voice
messages icon on Bria Enterprise to check for voicemail and listen to messages.
Completing this field enables the Voice messages icon. If you leave this field empty, the
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icon will not work and you will have to dial your voicemail number manually. Enter the
number provided by your VoIP service provider or system administrator.

Number for sending calls to voicemail: Complete this field only if your VoIP service
includes voicemail. This is the number that incoming calls will be forwarded to if they are
unanswered after the specified interval. This field must be completed if you select Send
call to voicemail if unanswered for. If you leave this field empty, Bria Enterprise never
forwards call to your service provider’s voicemail. However, most VoIP service providers
have their own mechanism for sending unanswered calls to voicemail. Leaving this field
blank does not mean that forward-to-voicemail does not work. Enter the number provided
by your VoIP service provider or your system administrator.

Send calls to voicemail if unanswered for: Complete this field only if your VoIP service
includes voicemail. Your service provider may have a similar feature outside Bria
Enterprise. If they do, make sure that you are not entering competing information in Bria
Enterprise and in the service provider’s interface. For example, if you clear this field in
Bria Enterprise, make sure that you turn this feature off with your service provider as well
or calls continue to be forwarded.

Selected: Bria Enterprise sends call to voicemail when the specified interval
expires. Enter the time interval in seconds.

Forwarding

Forward to: Forward to only works when Bria Enterprise is running and only if your VoIP
service provider supports redirect. You can use this feature even if your VoIP service
does not include voicemail.

Selected: All calls will be forwarded to the number specified. Inbound calls on
other SIP accounts (if you have them) are not affected by enabling this field.
Enter the number you want to forward your calls to.

When on the phone, forward to: When on the phone, forward to only works when Bria
Enterprise is running and only if your VoIP service provider supports redirect. You can
use this feature even if your VoIP service does not include voicemail.

Selected: Forward calls only when you are on another call. Inbound calls on
other SIP accounts (if you have them) are not affected by enabling this field.
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Your service provider may have a similar feature outside Bria Enterprise. If they do, make
sure that you are not entering competing information in Bria Enterprise and in the service
provider’s interface. if you clear this field, make sure that you turn this feature off with your
service provider as well.

Topology panel (SIP)
This panel controls how signals are passed through your network.

Note: These fields are view only.

Settings in the panel:

Firewall Traversal

Firewall traversal method: Choose the settings recommended by your VoIP service
provider.

Auto-detect firewall traversal method using ICE (Windows) / Auto-detect (ICE,
recommended) (Mac): Automatically determines the contact address for signaling
traffic. If selected, also set Firewall traversal server type.

Firewall traversal server type: In most cases, this setting can be left as
STUN and TURN. However, if you experience connection delays, change
this setting to STUN only or TURN only. This limits Bria Enterprise to
discovering only the STUN servers or only the TURN servers known to be
deployed in the network.

l STUN and TURN
l STUN only
l TURN only

Discover public IP address (STUN): Advertises the public IP address (discovered
via STUN) for the contact address for signaling traffic and for the connection
address for media traffic.

Use media relay (TURN): Advertises the public IP address (discovered via STUN)
for the contact address for signaling traffic.
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Use ICE: Advertises the public IP address (discovered via STUN) for the
connection address for media traffic.

None: Advertises the local IP address only for both signaling and media traffic.

Server address:

Empty: Discover the address of the firewall traversal server (the STUN or TURN
server), if available, using DNS SRV.

Specified: Use the firewall traversal server specified as either an IP address or a
fully qualified host name. If you use Auto-detect firewall traversal method using
ICE (Windows) or Auto-detect (ICE, recommended) (Mac), you can only enter a
STUN server here. Do not enter a TURN server because TURN is not supported
when ICE is used.

User name: The user name for the server.

Password: The password for the server.

Port Ranges

Range of ports used for signaling (Windows) / Range of ports used on local computer
(Mac): Set the range of ports on the local computer for SIP signaling.

Selected: Your computer is behind a restrictive firewall that only allows
specific port ranges to be used. Enter the port ranges for your SIP account
and also open the same ports on your firewall. Refer to applicable firewall
documentation for more information.

Cleared: You computer is not behind a restrictive firewall.

Range of ports used for RTP: Set the range of ports on the local computer RTP audio
and RTP video.

Selected: Your computer is behind a restrictive firewall that only allows
specific port ranges to be used. Enter the port ranges for your SIP account
and also open the same ports on your firewall. Refer to applicable firewall
documentation for more information.

Cleared: You computer is not behind a restrictive firewall.
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Custom DNS

Server 1 / Server 2: Enter the custom domain name server. A custom DNS is a domain
name server that is specific to a given domain (network or sub-network). It provides Bria
Enterprise the ability to query inside the network for IP addresses associated to domain
names rather than querying outside the domain.

Presence panel (SIP)
Presence allows other softphone users to see your online status and allows you to see
the online status of others.

Note: These fields are view only.

Settings in this panel:

Presence

Mode: Enter the value specified by your VoIP service provider.

Peer-to-peer

Presence agent

Poll time: The frequency, in seconds, that Bria Enterprise uses to check presence.

Refresh interval: The amount of time, in seconds, that Bria Enterprise refreshes your
presence.

Transport settings (SIP)
These settings display the method Bria Enterprise uses for transporting your SIP signal.

Note: These fields are view only.
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Settings in this panel

Transport

Signaling transport: Contact your VoIP service provider to identify the types of transport
that are supported.

Automatic: Bria Enterprise sets up the transport based on the capabilities of
the network and the Bria Enterprise computer. Choose this option if you do
not care which transport is used.

TCP (Transmission Control Protocol): This transport provides no signaling
security.

UDP (User Datagram Protocol): This transport provides no signaling
security.

TLS (Transport Layer Security): Choose this option to request signaling
encryption or both signaling and media encryption.

Media Encryption (Windows) / Media Encryption over TLS (Mac)

Media Encryption (Windows) / Media Encryption over TLS (Mac): Applies when TLS is
chosen as the Signaling transport method (see Signaling transport above).

Make and accept only encrypted call

Outgoing calls: Bria Enterprise places all outbound calls with TLS. The call
INVITE will specify SRTP media encryption. If the correct root certificates are
not in place or if the other party does not accept encrypted calls, the call will
fail.

Incoming calls: Bria Enterprise only accepts INVITEs that are for encrypted
calls. If Bria Enterprise receives a call INVITE that is not encrypted, the call
will be rejected.

Do not allow encrypted calls

Outgoing calls: Bria Enterprise only places unencrypted calls. If the other
party does not support unencrypted calls, the call will fail.
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Incoming calls: Bria Enterprise only accepts INVITEs that are for
unencrypted calls. Bria Enterprise only accepts INVITEs that are for
unencrypted calls.

Security

Verify TLS Certificate: Applies when TLS is chosen for transport.

Selected: Bria Enterprise attempts to verify one or more of the certificates
sent by the SIP server to see if they are trusted. If the certificates are trusted
by a well-known certificate authority such as VeriSign, no further action is
required. If the certificates are self-signed, install a corresponding CA
certificate on your device. Contact your VoIP service provider to get a
corresponding CA certificate.

Cleared: Bria Enterprise accepts the certificate without trying to verify it.

IPv6: Generally, leave this selected. Clear the check box only if advised by your VoIP
service provider or your system administrator.

Selected: Allows Bria Enterprise to make phone calls and send IMs over an
IPv6 network.

Advanced settings (SIP)
The Advanced panel allows you view registration intervals, timers, the hold method, and
mange connections.

Note: These fields are view only.

Settings in the panel:

Register Settings

Reregister every: The time interval measured in seconds between Bria Enterprise’s
attempts to reregister in order to refresh the account registration with the account’s VoIP
service provider. A value of zero means that Bria Enterprise should not attempt to
reregister after the initial registration. This value is placed in the Expires header field of
the REGISTER message.
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Minimum time: If the reregister fails, Bria Enterprise waits this amount of time, measure
in seconds, and then attempts to reregister. If the second attempt fails, Bria Enterprise
waits twice this time and tries again. Each time the attempt to reregister fails, Bria
Enterprise increases the amount of time between tries until registration succeeds.

Timers

Enable session timers: A session timer is a mechanism to detect whether a call session
still active from a signaling point of view. When the timer expires, a refresh is sent from
one party to the other. This timer is then reset.

Selected: Turns on the session timers.

Cleared: Turns off session timers, refreshes will never be sent.

Session time preference: Specifies how Bria Enterprise uses session timers.

Inactive: Session timers are not used in any session, except when it is
explicitly required in the remote request.

Optional: Session timers are used in all sessions whenever the remote party
supports and uses it.

Required: Session timers support is a requirement for the remote party to be
able to establish a session.

Always: Sessions timers are used in all sessions whether or not the remote
party supports or uses it.

Default session time: The default value of the session timer measured in seconds.

Hold Method

Hold method: Change this setting only if your VoIP service provider advises you to.

Handle hold request in M-line only (latest standard)

Handle hold request in M-line and C-line (old standard)

Connection Management

Send SIP keep-alives: Typically selected. Instructs Bria Enterprise to send SIP keep-
alive messages in order to maintain a “pinhole” through your firewall for SIP messaging.
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Use rport: Typically selected.

Use SIP Outbound: Determines Bria Enterprise uses an existing connection.

Selected: Bria Enterprise uses an existing connections by populating the SIP
header as specific to RFC 5626. The SIP server should communicate with
Bria Enterprise using the same connection if the transport is set to TCP or
TLS.

Cleared: Bria Enterprise does not use an existing connection.

Force outbound proxy on all requests: Typically Cleared. Use this setting only if you
have trouble connecting to the SIP server.

Selected: Requests always go to the outbound proxy configured in Send
outbound via on the Account (Windows) or General (Mac) panel. Bria
Enterprise never sends the invite directly to the end point. If you select this
field, make sure you also set Send outbound via.

Using a dial plan to modify how calls are placed
In Bria Enterprise, a dial plan can be used to modify how your calls are placed. For
example, a dial plan can change any number that starts with “+1613” to “613”. A dial plan
is used for any combination of the following reasons:

l To modify (transform) the input (the number to be dialed), such as to add the “9”
required to obtain an outside line from a PBX.

l To select the account to use to place a call, if users have more than one account.
For example, to use Account 1 to dial a number starting with 61, and use Account 2
to dial a number starting with 64.

Your administrator can set up dial plans for you. If you have any questions regarding dial
plans, talk to your administrator.

If you have multiple SIP accounts, it is recommended to set Outgoing Account to Auto
Select so that Bria Enterprise can access the dial plans of all enabled accounts. If it is set
to a specific account, Bria Enterprise only checks the dial plan of the selected account.
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XMPP account settings
An XMPP account is optional. If you have an XMPP account, it will automatically be used
for presence subscriptions and instant messaging. End users can pull their XMPP
contacts into Bria Enterprise’s contacts and IM these contacts from Bria Enterprise.

General account settings (XMPP)
This panel let you view User Details, and signal transport for the XMPP account.

Settings in this panel:

Account name: Used to identify the account. If desired, change the name to something
meaningful to you. For example, the Corporate Account.

Protocol: Read-only. Always specifies XMPP.

User Details

User ID: The XMPP (Jabber) user ID. Provided by your XMPP service provider. For
example, bhart.

Domain: The domain portion of your XMPP address. Provided by your XMPP service
provider.

Password: The password for your XMPP account. Provided by your XMPP service
provider.

Display name: This is the name that is displayed in the Bria Enterprise. Remote parties
see this name when they are connected to you.
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Synchronization

Enable synchronization of messages

Selected: Bria Enterprise synchronizes XMPP messages between your
clients on all devices.

Cleared: Bria Enterprise shows messages on the device that they were sent
on.

Advanced

Port selection: Configures the port to use.

Auto detected: Bria Enterprise automatically detects the port to use

User selected: Enter the Connect port.

Connect port: Complete only if Port selection is set to User selected.

Outbound proxy:The value in the User ID and in this setting may be used by Bria
Enterprise to compose a valid jid (Jabber ID).

If User ID=aphillips@ABC.com and the Outbound proxy is empty, the
jid=User ID: aphillips@ABC.com.

If User ID=aphillips@ABC.com/home and the Outbound proxy is empty, the
jid=User ID: aphillips@ABC.com.

If User ID=aphillips@ABC.com and the Outbound proxy=XYZ, ignore the
Outbound proxy; the jib=User ID: aphillips@ABC.com.

If User ID=aphillps@ABC.com and the Outbund proxy=IP address or host
address, the jid=User ID: aphillips@ABC.com

If User ID=aphillips and Outbound proxy=ABC.com,
jid=aphillips@ABC.com.

Resource: Optional resource as specified in RFC 3920, for example, home/. If this setting
is blank and the User ID includes a resource, the value from User ID is used. If both are
specified, the value of the Resource is used. If no resource is specified, the XMPP server
will assign a temporary resource.

Priority: The priority as per RFC 3921. The default is zero.
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Verify TLS Certificate:

Selected: Bria Enterprise attempts to verify one or more of the certificates
sent by the XMPP server to see if it is trusted. If the certificate is trusted by a
well-known certificate authority such as VeriSign, no further action is required.
If the certificate is self-signed, install a corresponding CA certificate on your
device. Contact your XMPP service provider to get a corresponding CA
certificate.

G-Suite account settings
You can integrate your G-Suite contacts into Bria Enterprise by adding your G-Suite
account.

There are no settings in your G-Suite account.

Windows Outlook account settings
You can enable your Outlook account to provide Bria Enterprise with access to the
contacts in your address book. When you integrate Outlook contacts using an Outlook
account, the contacts are continually synced with the contacts in Outlook. By mapping
contact addresses to fields in Bria Enterprise, you can make calls and send messages to
Outlook contacts from either Bria Enterprise or from within Outlook.

Settings in the panel

Account
Protocol: Read only. Always specifies Outlook.

Account Details

Field to use for Softphone address: If you are using SIP for presence, you can set up
Bria Enterprise to treat one of the contact fields in Outlook as a SIP address that can be
subscribed to.
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If you select Business Telephone Number in this field, any values that are in
the Business Telephone Number field in Outlook are copied to the Softphone
field in Bria Enterprise and Bria Enterprise subscribes to the online status of that
contact through your SIP account. If an Outlook contact has “2766” in Outlook’s
Business Telephone Number field and your SIP account domain is
“domainA.com”, Bria Enterprise subscribes to “2766@domainA.com”.

Field to use for IM address: If you have an XMPP account, you can set up Bria
Enterprise to treat one of the contact fields in Outlooks as an XMPP address that can be
subscribed to.

If you select IM Address in this field, any values that are in the IM Address field
in Outlook are copied to the Instant Message field in Bria Enterprise and Bria
Enterprise subscribes to the online status of that contact through your XMPP
account. If an Outlook contact has “aphillips@acphone.com” in Outlook’s IM
Address and the domain of your XMPP account is acphone.com, Bria
Enterprise subscribes to “aphillips@acphone.com”.

Setting up Mac Address Book accounts
Bria Enterprise pulls the Mac Address Book contacts into Bria Enterprise’s contacts. You
can phone or IM them directly from Bria Enterprise.

Setting up Mac Address Book account
Setting up the Mac Address Book account in Bria Enterprise allows you to directly call or
IM the contacts in your Mac Address Book.

To set up the Mac Address Book account

1. On the menu bar, click Bria Enterprise – Preferences. The Preferences window
opens.

2. Click on the Accounts tab.
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3. Click + at the bottom to add an account.

4. Select Mac Address Book. Make sure to enable the account.

Bria Enterprise pulls in the contact with the specified number already set up as a
softphone address.

Using your Mac Address Book for presence
If your Mac Address Book contains phone numbers that you know can be used to obtain
online activity information about the person through your SIP account, you can perform
this additional step.

To set up for presence

1. In the Mac Address book make sure that the contact type is Phone and the label is
softphone (in lower case).

2. On the menu bar, click Bria Enterprise – Preferences. The Preferences window
opens.

3. Click on the Accounts tab.

4. Make sure your Mac Address Book account is enabled. Bria Enterprise pulls in the
contact with the specified number already set up as a softphone address.

5. Open the contact in Bria Enterprise and choose the specified phone number in the
Primary Presence field and click OK.

Bria Enterprise obtains the presence for this contact.

Permissions
Bria Enterprise requires permission to use your Mac contacts on macOS Mojave and
higher. If you are having issues with your Mac Address Book, check to make sure Bria
Enterprise has access to your contacts.
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To give macOS contacts permission to Bria Enterprise

1. Click to open the Apple menu and select System Preferences.

2. Click Security & Privacy and select the Privacy tab.

3. Find the Contacts category. Select Bria Enterprise to allow access.

Bria Enterprise's permissions are updated.
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Preferences

There are two ways of configuring Bria Enterprise – Account Settings and Preferences.

Account Settings are settings that only apply to an individual account.

Preferences are settings that let you control the way that you work in Bria Enterprise.
Preferences also contains fields to configure features that apply globally rather than on a
per-account basis.

This section describes Preferences.

For Windows, click Preferences on the Softphone menu. For Mac, click Preferences
from the Bria Enterprise menu on the menu bar.

Preferences: Application panel
This panel lets you set preferences for the general user interface.

Settings in the panel:

General Preferences (Windows)

Language: The language you want the app to run in. Restart Bria Enterprise for the
change to take effect. Supported languages are English (US), Dutch, French, German,
Italian, Japanese, Portuguese, Russian, Simplified Chinese, and Spanish.

Launch when Windows starts: Determines whether you need to start Bria Enterprise
manually.

l Selected: Bria Enterprise Bria Enterprise launches when you start Windows.
l Cleared: Start Bria Enterprise manually.

Call immediately once a phone number is selected: Restart Bria Enterprise for the
change to take effect.

CounterPath an Alianza Company 232

Bria Enterprise User Guide Preferences



l Selected: You can start a Bria Enterprise call without click the Make a call button.
l Cleared: You must click the Make a call button to start a call.

Set Bria Enterprise as your default softphone: This works for Windows 7 only. See
Setting Bria Enterprise as your default softphone to set Bria Enterprise as your default
softphone in Windows 10.

Enable hardware acceleration: Turn off hardware acceleration for Windows
Presentation Foundation (WPF). Turning this setting off is useful for graphics cards that
do not support WPF.

l Selected: Hardware acceleration is used.
l Cleared: Hardware acceleration is not used.

Enable/Disable Outlook integration: See Office integration.

General Preferences (Mac)

Pause Music when making or receiving calls:

l Selected: Bria Enterprise pauses Apple Music when you are using Bria Enterprise
to place and receive calls. Note that it does not stop anything else such as Spotify
or YouTube; you will have to pause it manually.

l Cleared: Bria Enterprise does not pause Apple Music when you are using Bria
Enterprise to place and receive calls.

Set Bria Enterprise as your default softphone: Determines whether Bria Enterprise is
your default softphone.

l Selected: Bria Enterprise is your default softphone.
l Cleared: Bria Enterprise is not your default softphone.

Call immediately once a phone number is selected: Restart Bria Enterprise for the
change to take effect.

l Selected: You can start a Bria Enterprise call without click the Make a call button.
l Cleared: You must click the Make a call button to start a call.

Note: The language on Bria Enterprise is controlled by macOS system primary language.
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Messages & Presence

Display idle status if I don’t use my computer for:

l Selected: Bria Enterprise automatically changes your status to Idle if you have not
used your computer for a set amount of time.

l Set the amount of time here. Time is measured in minutes.

In messaging, pressing Enter will: Set the action for pressing ENTER when you are
composing an IM.

l Send the message (Use SHIFT + ENTER to create a line) (Windows)
l Create a new line (Use SHIFT+ ENTER to send) (Windows)
l Send the message (Use CTRL+ ENTER to create a new line) (Mac)
l Create a new line (Use CTRL+ ENTER to send) (Mac)

Show timestamp on messages: Changing this setting affects all messages in your
history.

l Selected: Bria Enterprise displays date and time information in the message.
l Cleared: Cleared: Bria Enterprise only displays the message content.

You can always hover over a message to get the date and time information.

Show hyperlink preview on messages: Bria Enterprise can display a preview for any
hyperlinks that appear in Messages.

l Selected: Bria Enterprise shows a hyperlink preview in the message.
l Cleared: Bria Enterprise does not show a hyperlink preview in the message.

Messaging Font Face: Use the drop-down box to select a different font for your
messages.

Messaging Font Size: Use the drop-down box to select a font size for your messages.

Default Actions

This section lets you configure the default action for the Call and Transfer buttons and
the action that occurs for double-clicking on a contact.

CounterPath an Alianza Company 234

Bria Enterprise User Guide Preferences



l You can set the action of the Call button to Call, Make a video call, or Start a
conference.

l You can set the action of the Transfer button to Call First for attended transfers or
Transfer Now for unattended transfer. You can use the drop-down to change the
action of the button on an individual call basis. See Transferring a call.

l You can set the action for double-clicking to Call, IM, or E-mail.

Button: Use the drop-down list to select the button you want to change the default action
for.

l Call
l Transfer

Default Action: Use the drop-down list to set the action that occurs when you single-click
on the Call or Transfer button.

Call button

l Call
l Make a video call
l Start a conference
l Call First
l Transfer Now

Transfer button

l Call First
l Transfer Now

Action when double-clicking on contact: Use the drop-down list to set the action that
occurs when you double-click on a contact.

l Call
l IM
l E-mail

Security
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This section lets you decide what happens when another application requests Bria
Enterprise API access. It also allows you to see if you have allowed or denied access to
APIs and change the access.

When an application requests Bria Enterprise API access: Select one of the options to
determine how API requests are handled.

l Prompt to all access each time
l Allow access always
l Deny access always

Allowed Applications and Denied Applications: When Prompt to allow access each
time is selected, move applications that have requested API access between columns.

Preferences: Alerts and sounds panel
This panel lets you change the way you are notified of calls, IMs, and messages.

For information on the device that Bria Enterprise uses for ringing, incoming audio, and
incoming video, see Preferences: Devices panel.

Enabling alerts
You can set up Bria Enterprise to send an alert in the following events:

l For an incoming call
l When a contact comes online
l When a contact goes offline
l For IMs
l For SMS
l For new mentions in a chat room

Select Enable alert displays to enable alerts for all the actions. Once Enable alert
displays is selected, you can select which events you want to receive an alert for.

For Windows 10, see Configuring OS notifications to make sure system notifications are
enabled.
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Windows

In Windows, you will receive an notification from Bria Enterprise. If you are running
Windows 10, you may receive a Windows 10 interactive toast notification or a Windows 7
style notification. The Windows 10 interactive toast notification is sent when you select
Use Windows notifications in Preferences > Alerts & Sounds .

Windows 7 style notification

A Bria Enterprise alert allows you to answer a call, answer a call with video (if the remote
party initiated a video call), or decline a call.

Windows 10 interactive toast notifications

With an interactive toast notification, you can answer or decline the call, or you can
decline the call and send an IM to the remote party. The incoming call notification
displays the name of the remote party and the number they are calling from. If you have
more than one SIP account, the notification also displays the account that the call is
received on.
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Mac

Bria Enterprise uses OS notifications. Make sure that the notifications are set up for Bria
Enterprise in the Mac system preferences.

Setting up OS notifications

1. From the menu, click the Apple logo and click System Preferences >
Notifications.

2. Click Bria Enterprise.

3. Choose the banner or alert notification style.

You will receive either a banner or alert notification when you have an incoming call or
instant message on Bria Enterprise. Banner style notifications appear briefly in the top
corner of the screen. They will disappear on their own. Alert styles notifications appear
and remain on the screen until you take action on them.

Banner and alert notifications

If you receive a banner notification, you can click on the notification to open the call panel
or the Messages window.

If you receive an alert style notification for a phone call, you can click Answer or Decline
on the notification or click anywhere else on the notification to open the call panel.

If you receive an alert style notification for an IM, you can click Close or click anywhere
else on the notification to open the Messages window.

Enabling sounds
You can set Bria Enterprise up to play a sound in the following events:

l For an incoming call
l For call waiting
l For auto answer
l For hangup

CounterPath an Alianza Company 238

Bria Enterprise User Guide Preferences



l For an incoming IM
l For an incoming SMS
l When mentioned (@) in a Room
l When a contact comes online
l When a contact goes offline

Select Enable sounds to turn on sounds for all the actions. Once Enable sounds is
enabled, you can select whether you would like to hear a sound for each event.

You can assign a sound for each event. Click on the event you want to change the alert
sound for. Use Browse to locate the file you want to use. The sound file must be an
uncompressed WAV file, which is also called a PCMWAV file. If your WAV file does not
work, try converting your WAV file to PCM format.

For Windows 10, see Configuring OS notifications to make sure system notifications are
enabled.

Settings in the panel

Alerts

Enable alert displays: Determines if Bria Enterprise displays notifications. Once Enable
alert display is selected, you can select whether you receive an alert For an incoming
call, When a contact comes online, When a contact goes offline, or For IMs (show
alert instead of automatically opening the IM window) by selected or clearing the
corresponding box.

Selected: You can set up alerts for incoming calls, contact presence, and IMs.

Cleared: Bria Enterprise flashes in the taskbar (Windows) or the Dock (Mac)
for incoming calls, contact presence changes, and IMs.

Windows 10 only: Bria Enterprise sends a Windows 7 style notification or a Windows
interactive toast notification.

Use Windows notifications (Windows only): Determines whether Bria Enterprise sends
Windows 7 style notifications or Windows 10 interactive toast notifications.

Selected: Bria Enterprise sends Windows 10 interactive toast notifications.
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Cleared: Bria Enterprise sends Windows 7 style notifications.

Sounds

Enable sounds: Determines if Bria Enterprise plays sounds for notifications. Once
Enable Sounds is selected, you can select whether a sound is played For an incoming
call, For call waiting, For auto answer, For hangup, For an incoming IM, When a
contact comes online or When a contact goes offline by selected or clearing the
corresponding box.

Selected: You can set up Bria Enterprise to play sounds for calls, contact
presence, and messages.

Cleared: Bria Enterprise flashes in the taskbar (Windows) or the Dock (Mac).

Sound preference: If you have enabled sounds for an event, you can select the individual
event and choose a sound to play for that event.

Click Browse and find the file locations for the sound you want to use.

Click Reset to go back to the default sound.

Preferences: Devices panel
This panel lets you select your Speaker and Microphone in Headset Mode and in
Speakerphone Mode, and lets you select which device should ring, your Camera, and
the maximum resolution for video.

Unless you have made changes in Devices, Bria Enterprise automatically detects
devices at each startup and selects the most appropriate device for audio and video. Your
choices apply at the next start up unless the device is no longer in use, in which case,
Bria Enterprise will automatically detect the device to use.

On a new install, Bria Enterprise uses your system default device for the speaker and the
microphone.

Test Devices: Opens the Troubleshooting window.

Allow device integration: Enabled by default. Turn off if you have issues with your audio
devices (such as headsets and speakers) and you are advised by Support to turn it off.
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Enable echo cancellation: Reduces echo from speakers and headsets. Enabled by
default.

Headset Mode

Change these fields only if you want to override the devices that Bria Enterprise
automatically selected.

Speaker: Click the drop-down arrow to see the devices detected by Bria Enterprise.
Select the device you want to use for the speaker when you are using a headset.

Microphone: Click the drop-down arrow to see the devices detected by Bria Enterprise.
Select the device you want to use for the microphone when you are using a headset.

Speakerphone Mode

Change these fields only if you want to override the devices that Bria Enterprise
automatically selected.

Speaker: Click the drop-down arrow to see the devices detected by Bria Enterprise.
Select the device you want to use for the speaker when you are in speakerphone mode.

Microphone: Click the drop-down arrow to see the devices detected by Bria Enterprise.
Select the device you want to use for the microphone when you are in speakerphone
mode.

Other Devices

Ring on: Change this field only if you want to override the devices that Bria Enterprise
automatically selected.

Click the drop-down arrow to see the devices detected by Bria Enterprise. Select the
device where you want to hear the phone ringing.

Camera: Change this field only if you want to override the devices that Bria Enterprise
automatically selected.

Click the drop-down arrow to see the devices detected by Bria Enterprise. Select the
device you want to use as your video camera.

Max Resolution: Click the drop-down arrow and select the maximum resolution you want
to use for your outgoing video.

CounterPath an Alianza Company 241

Bria Enterprise User Guide Preferences



VGA (4:3): Video graphics array, uses 640 x 480 pixels.

480P (16:9): Sometimes called as widescreen VGA, uses 848 x 480 pixels.

720P (16:9): High definition video, uses 1280 x 720 pixels.

1080P (16:9): High definition video, uses 1920 x 1080 pixels.

Set to the highest resolution if you have a good camera, a high speed internet
connection, and a computer with a fast CPU. You will know if you have set the resolution
too high if your computer slows down or the video shows black areas or is slow or jerky.

Set to the lowest resolution only in special situations — using Wi-Fi in a hotel. You will
know if you have set the resolution too low if the video is fuzzy.

You can test the resolution by clicking View > Video once you set this field.

Video Render Mode: Click to select the render mode for your incoming video. Options
are: Auto, DirectX 9, DXVA-HD. Auto by default.

Change it to DirectX 9 if you have issues with video such as displaying incorrectly or
corrupted when a video window is resized.

Camera Rotation: Available on Windows. Some cameras do not rotate correctly when
you change the display rotation on Windows (for your main monitor). The setting Camera
Rotation on Bria Enterprise allows you to fix the situation where video feed ends up in the
wrong direction after the main display rotation has been changed on Windows. Close and
reopen the Video window to see the change.

Normal(Default) : Your video feed appears in the display orientation set on
Windows for your main monitor.

Flipped: Try this setting if your video feed appears mirrored or in an opposite
direction.

None: Use this setting for a stationary camera when you want the camera
orientation to be different from the main display orientation (e.g., main display
is in Portrait while video feed is in Landscape). Select None here, then set the
camera orientation you want in the OS under Settings > Devices > Bluetooth
& other devices.
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Note: When using a Jabra device, you need to select the device in Speaker and Microphone,
rather than use Default Device or Default Communication Device.

Preferences: Shortcut keys panel (Windows)
Bria Enterprise supports system-wide shortcut keys and keyboard accelerators. This
topic describes how to enable shortcut keys. For keyboard accelerators, see Bria
Enterprise Desktop keyboard accelerators.

l Shortcut keys work regardless of whether Bria Enterprise is in focus or not. Other
applications on your device may interfere with these operations. Bria Enterprise
shortcut keys are disabled by default until you enable them under Preferences.

l Keyboard accelerators apply only when Bria Enterprise is in focus. They are
keyboard combinations that speed up common interactions with Bria Enterprise.
They cannot be enabled/disabled, or customized.

Activity Key combination

Answer call CTRL+SHIFT+ALT+A

Hang up call CTRL+SHIFT+ALT+H

Bring focus on Bria Enterprise CTRL+SHIFT+ALT+B

Toggle mute CTRL+SHIFT+ALT+M

Redial CTRL+SHIFT+ALT+R

Dial selected text CTRL+SHIFT+ALT+D

Focus on Joined Screen Share CTRL+SHIFT+ALT+S

System-wide shortcut keys

On the Shortcut keys panel of the Preferences window, select Enable shortcut keys to
use the shortcuts in Bria Enterprise. You can also enable or disable individual shortcut
keys by selecting or clearing Enable for each action.

To customize shortcut key combinations

You can change the default shortcut key combinations.
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1. Make sure Enable shortcut keys is selected and the action you want to change is
enabled.

2. Select an Action and click Edit. The Edit Shortcut Key window opens.

3. Select the keys that you want to use in the new combination. Select at least two
keys.

4. Type the desired letter or number in the field.

5. Click Assign.

You can use the new shortcut key combination for the action you selected.

Shortcut key combination rules

The following rules apply to shortcut key combinations.

l You cannot override a standard Microsoft Windows combination such as
CTRL+ALT+DELETE.

l The shortcut applies when Bria Enterprise is running, regardless of the application
that is in focus.

l If another program uses the same shortcut key combination, the application that
was started later has control over that combination.

l If a shortcut key combination is not valid at a particular moment, entering the
combination has no effect. For example, CTRL+SHIFT+ALT+A has no effect if there
is no incoming call on Bria Enterprise.

Preferences: Calls
This panel allows you to configure auto answer, caller ID, call blocking , and DTMF.

Answer calls

This section allows you to set preferences for the auto answer feature.

Tip: Auto answer is disabled until you manually enable it on the on-screen phone. To enable
auto answer, see Enabling auto answer.
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Auto answer after: The time, in seconds, that Bria Enterprise waits to answer a call when
Auto Answer is enabled. Select the number of seconds from the drop-down list. This field
can be set from 0 (zero) to 5 seconds. Choose 0 if you want Bria Enterprise to answer
calls immediately. Also pick one of the following:

Auto answer with audio: When Auto Answer is enabled, Bria Enterprise answers
calls with audio only.

Auto answer with audio and video: When Auto Answer is enabled, Bria Enterprise
answers calls with audio and video.

Caller ID

Match Contacts for Caller-ID

Selected: Bria Enterprise tries to match incoming calls with Contacts or Roster. If a
match is found, Bria Enterprise uses the contact's Display name in the caller ID.

Cleared: Bria Enterprise uses the information in the SIP header for the caller ID.

Call Blocking

l Block incoming calls with no number
l Block incoming calls with anonymous Caller ID
l Blocked numbers

Type in a number you want to block. Make sure to press Enter. You can add up to
10 phone numbers.

DTMF

Select a method Bria Enterprise uses when using dual-tone multi frequency (DTMF) or
interactive voice response.

You may need to change this method if you cannot interact with interactive voice
response systems — auto attendants, voice-activated menus. Contact your VoIP service
provider or your system administrator for the correct setting.

l Send via RFC 2833
l Send via INFO
l Send in-band
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l RFC 2833 and SIP INFO
l In-band and SIP INFO

In-band means that Bria Enterprise encodes DTMF signals in the audio stream as regular
sound. Typically, DTMF is not send in-band.

You may want to use in-band if all three conditions apply:

l You own your own gateway.
l One or more gateways do not support RFC 2833 or do not handle it well.
l Your gateway is using codes that reproduce DTMF codes well.

In this case, sending in-band ensures your DTMF tones get through because they bypass
the gateway and they are reproduced accurately on the receiving end.

Play DTMF tones back to me

Selected: Bria Enterprise plays key tones through your speaker when you dial.

Cleared: Bria Enterprise does not play key tones.
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Troubleshooting

This topic covers common errors as well as how to send a log to Customer Support.

Use the Troubleshooting window in Bria Enterprise to make sure your headsets and
speakers are working without having to actually place a call.

Troubleshooting common errors
Error 408

408 Request Timeout (no response received from the server)

It means that Bria Enterprise cannot reach the SIP server (VoIP service provider or PBX),
or the server is not responding.

l Make sure you or your admin entered the correct domain name and outbound proxy
for your SIP server.

Tip: Include a port number after the domain and/or outbound proxy, such as
counterpath.com:5061 if your service provider requires a port other than 5060 (ie,
using TLS as transport). If no port is specified, Bria Enterprise uses 5060.

l Try changing the firewall strategy used in Bria Enterprise. Bria Enterprise supports
multiple options, and you are going to try each one to see which one works for your
network.

If the problem persists, contact your VoIP service provider, and ask if they are
receiving registration requests from Bria Enterprise on your SIP account. Also
double check the transport type (UDP/TCP/TLS) and port number. In some cases,
your service provider might need to whitelist your IP address in order to reach their
server.
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l Disable SIP ALG on your router if it has this option. SIP ALG (Application-level
gateway) is a common feature of consumer routers that aims to help VoIP traffic get
routed properly, but it could also cause issues with VoIP traffic.

l If this error occurs in a different network than the previous ones you used, check to
see if a VPN is used in your network. VPNs could potentially block VoIP traffic.

l If you have strict firewall rules, you might need to open ports on your network and
change firewall rules. This allows traffic from the various servers communicating
with Bria Enterprise.

See this page for details.

Error 503

503 Service Unavailable (may also say Internal Server Error)

l You or your admin requested TLS or TCP transport, but the SIP server is not
configured for this service. Make sure your transport type and encryption settings
are correct. Revert to UDP transport for now, and contact your VoIP service
provider for details.

Using Bria Enterprise diagnostics
You may be asked to generate a packet capture, which capture the network traffic on
your computer, in addition to a log report. Packet capture is not supported over network
changes, such as changing from a wired network to a Wi-Fi network. When you generate
a packet capture, you also create a log report.

Warning: While packet capturing is in progress, all network traffic on your computer is
captured. All other applications that generate network traffic should be shut down or
suspended before starting packet capture to avoid complex filtering of network traffic during
analysis and to minimize privacy concerns.

To send a log report

1. In Bria Enterprise, go to Help > Troubleshooting> Support.

2. On the Support tab, change the log level to Debug by moving the slider.
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3. Close the Troubleshooting window.

4. Restart Bria Enterprise.

5. Try to recreate the problem you are having.

6. Return to the Support tab in Help > Troubleshooting.

7. Click Send Log Report. The Send Log Report window opens.

8. Type a brief description of the problem you are having and click Send Log
(Windows) or Send Log Report (Mac).

Once the log is sent, it will be listed under Previous Log Reports.

9. Save the reference number and forward it to Customer Support.

Bria Enterprise sends the log to Customer Support.

To send a packet capture and a log

1. Other than Bria Enterprise, shut down or suspend any apps that generate network
traffic.

2. On the Help menu, click Troubleshooting. The Troubleshooting window opens.
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3. On the Support tab, change the log level to Debug by moving the slider.

4. On the Support tab, click Start Packet Capture. The Packet Capture window
opens.

5. If this is your first time using packet capture or if you have uninstalled Npcap, click
Enable Packet Capture. An installer dialog box appears. Follow the instructions to
install Npcap and select Support loopback traffic on Installation Options.
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When the installation is complete, click Start Packet Capture. The Packet Capture
window opens.

6. Click Start Capture.

7. Reproduce the problem you are having.

8. Click Stop Capture.

9. Click Send Log Report. The Send Log Report window opens.

10. Type a brief description of the problem you are having and click Send Log
(Windows) or Send Log Report.
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Bria Enterprise sends a zip file containing both the packet capture and the log report to
CounterPath.

To cancel a packet capture

1. Either during the packet capture or when you have stopped but not send the packet
capture, click Cancel and Discard.
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The current package capture stops and any data collected is discarded.

To view the last report log

1. On the Help menu, click Troubleshooting. The Troubleshooting window opens.

2. On the Support tab, click View Log (Windows) or View Current Log (Mac).

The log opens in your default app for opening .txt files.

Bria Enterprise displays the reference number of previous logs. You cannot view the
previous logs but the reference number could be helpful when you are talking to customer
support. The customer support representative can view the previous logs and can use the
reference number to find the correct log.

.

Troubleshooting microphone and speaker
Use the Troubleshooting window in Bria Enterprise to make sure your headsets and
speaker are working. Go to Help > Troubleshooting to display the Troubleshooting
window.

Devices panel
You can verify that your microphone and speakers are working and can set the volume to
a comfortable level without having to place a call. You can also check the image from
your camera before starting a video call.
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1. Select the microphone that you want to use from the drop-down menu.

2. Speak into the microphone. If Bria Enterprise detects sounds, you see Your
microphone works.

3. Select the speakers that you want to use from the drop-down menu.

4. Click the Play button while listening to the speakers. Drag the volume slider to set
the volume to a comfortable level. If your speakers are working, you see Your
speakers work.

5. Click Test for the camera.

Tip:
Pausing music when making or receiving calls

For Mac users:

The Bria Enterprise for Mac app has a preference for pausing Apple Music. It does
not stop anything else such as Spotify or YouTube; you will have to pause it
manually.

For Windows users:

Windows offers a feature called "Default Communication Device" where users can
choose whether to stop music or reduce volume when Windows detects
communication activities such as making and receiving calls.

To use this feature, you need to configure both Windows and Bria Enterprise.

1. Set your headsets to be Default Communication Device on Windows. Right-
click on the Speaker icon in Windows taskbar, then click Sounds, and click the
Playback tab. Select the headsets you want to use for phone calls and right-
click to show the menu and choose Set as Default Communication Device.
Click Apply.
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2. In Bria Enterprise app, go to Softphone > Preferences > Devices, then choose
Default Communication Device as your headsets.

To change the behavior when Windows detects communication activities:

1. Right-click on the Speaker icon in Windows taskbar, then click Sounds.

2. Click the Communications tab and select an option for muting or reducing
volume.

3. Click Apply.

Audio panel
While you are on a phone call, you can test the quality of the audio.

Note: To perform a valid test, you should be on an established call and not on a call attempt.

Video panel
While you are on a video call, you can test the quality of the video.
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Note: To perform a valid test, you should be on an established call and not on a call attempt.
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Reference

Administrator
Setting the primary number in an XMPP vCard
If you have access to XMPP vCard configuration on the XMPP server, you can set a
PREF tag for a specific number to be used as a primary phone number on Bria
Enterprise. For example, if a contact has 3 numbers - home, work and mobile, you can
set the work number as primary by adding a PREF tag in vCard configuration. When end
users double-click the contact, the primary number will be called.

Example

<TEL><PREF/>
<WORK/>
<VOICE/>
<NUMBER>6045551234</NUMBER>

</TEL>
<TEL>

<HOME/>
<VOICE/>
<NUMBER>6045559999</NUMBER>

</TEL>
<TEL>

<CELL/>
<VOICE/>
<NUMBER>7785551234</NUMBER>

</TEL>
...

Other ways to use Bria Enterprise
This section describes how to set Bria Enterprise as your default program, how to run
Bria Enterprise from a hyperlink, and how to run Bria Enterprise from the command line.
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Setting Bria Enterprise as your default softphone
Bria Enterprise supports three protocols: SIP, TEL, and CALLTO. You can set Bria
Enterprise as the default app for these three protocols.

To set Bria Enterprise as your default softphone in Windows 10

To set Bria Enterprise as your default app in Windows 10, you have to go into Windows
settings.

1. Open Windows Settings.

2. Click on Apps.

3. Click on Default apps.

4. Scroll to the bottom of the screen and click Set defaults by app.

5. Proceed depending on the screen you see.

a. Click Bria Enterprise in the Programs list.

b. Do one of the following:
l To set for all three protocols, click Set this program as default.
l To pick some of the protocols, click Choose defaults for this program.
Select the protocol in the list, and click Save.
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a. Click Bria Enterprise and click Manage.

b. For each protocol, click Choose a default and select Bria Enterprise.

Bria Enterprise is set as your default applications for the CALLTO, SIP, and/or TEL
protocols.

To set Bria Enterprise as your default softphone – Mac

1. Click Preferences on the menu.

2. On the Application panel, enable Set Application as your default softphone.

Bria Enterprise is set as your default application for the CALLTO, SIP, and TEL protocols.

Other ways to start Bria Enterprise
Bria Enterprise can be started from a hyperlink or a Windows command line.

To start Bria Enterprise from a hyperlink

You can attach a hyperlink to a phone number or a softphone address that starts Bria
Enterprise and dials the number when it is clicked. For Bria Enterprise to start dialing
when a user clicks the hyperlinks, the user must configure Bria Enterprise as the default
phone and associate Bria Enterprise to the protocols.

Attach a hyperlink in this format:

<a href="sip:address_or_number">dial address_or_number</a>

For example:

<a href="sip:aphillips@domainA.com">dial aphillips@domainA.com</a>

Tip:
With the tel protocol, you can call an extension from a hyperlink. For example:

<a href="tel:+16045553727;ext=1">dial +1-604-555-3727 Extension 1</a>

Note a semicolon (;) between a phone number and an extension. When a hyperlink
is clicked, Bria Enterprise dials the number and pauses before dialing an extension.
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Make sure you use the tel protocol; the other protocols do not support calling an
extension.

Bria Enterprise Desktop keyboard
accelerators
Keyboard accelerators apply only when Bria Enterprise is in focus. They are keyboard
combinations that speed up common interactions with Bria Enterprise. They cannot be
enabled, disabled, or customized. They are different from system-wide shortcut keys that
can be customized in Windows.

Windows

Making or answering a call

CTRL+N: Answer an incoming call

CTRL+D: Decline an incoming call

CTRL+R: Redial the last number called

CTRL+E: End a call or end a conference call (hang up on all participants)

During a call

CTRL+M: Mute or unmute your voice

CTRL+H: Hold or resume a call when the focus is on the call panel

CTRL+T: Transfer an established call when the focus is on the call panel

↑ (Up arrow): Turn the call volume up when the focus is on the call panel

↓ Down arrow: Turn the call volume down when the focus is on the call panel

F11: Display the Video window in full screen when the focus is on the Video windows
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Presence

CTRL+W: Change presence to Do not disturb or change presence from Do not disturb to
the default status, usually Available when the focus is on the onscreen phone

During a screen share session

SHIFT+CTRL+ALT+S: Bring the screen share window to the front and in focus

During a Collaboration meeting

CTRL + SHIFT + C: Bring the active Collaboration meeting into focus from the main
window

CTRL+M: Mute or unmute your voice

CTRL+H: Hold or resume a conference call

CTRL+V: Pause or resume sending your video (to control whether or not other
participants see you)

CTRL+S: Start or pause sharing your screen

Opening a window

SHIFT+CTRL+M: Open the Messages window

F8: Open the Preferences window

CTRL+F9: Open the Support tab in the Troubleshooting window

F1: Open Help in a browser

Exiting

CTRL+Q: Quit Bria Enterprise.

Mac

Making or answering a call

CTRL+N: Answer an incoming call

CTRL+D: Decline an incoming call

CTRL+R: Redial the last number called
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CTRL+E: End a call or end a conference call (hang up on all participants)

During a call

CTRL+M: Mute or unmute your voice

CTRL+H: Hold or resume a call when the focus is on the call panel

CTRL+T: Transfer an established call when the focus is on the call panel

↑ (Up arrow): Turn the call volume up when the focus is on the call panel

↓ (Down arrow): Turn the call volume down when the focus is on the call panel

Presence

CTRL+W: Change presence to Do not disturb or change presence from Do not disturb to
the default status, usually Available

During a Collaboration meeting

COMMAND + SHIFT + C: Bring the active Collaboration meeting into focus from any Bria
Enterprise window

CTRL+M: Mute or unmute your voice

CTRL+H: Hold or resume a conference call

CTRL+V: Pause or resume sending your video (to control whether or not other
participants see you)

CTRL+S: Start or pause sharing your screen

Opening a window

SHIFT+COMMAND+M: Open the Messages window

COMMAND+,: Open the Preferences window

CTRL+F9: Open the Support tab in the Troubleshooting window

SHIFT+COMMAND+V: Open the Video window

SHIFT+COMMAND+?: Open Help in a browser
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Exiting

COMMAND+Q: Quit Bria Enterprise.

Allowing API access
Occasionally, another application, such as Jabra Direct, Plantronics Hub, or Sennheiser
HeadSetup Pro, requests access to Bria Enterprise. You have to grant the application
access to the API either manually or automatically, depending on your settings in the
Security tab in Preferences > Application.

To view the Security tab, go to Preferences > Application, and click the Security tab in
the middle of the screen.

Allowing access automatically
To allow or deny access to third party applications requesting access to the Bria
Enterprise API, set When an application requests Bria Enterprise API access to either
Allow access always or Deny access always.

Allowing access each time
If you have When an application requests Bria Enterprise API access: set to Prompt to
allow access each time, a notification appears in Bria Enterprise.
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To allow API access

1. Click Notifications on the resource panel.

2. Click Allow Access.

The third party application has access to the Bria Enterprise API.

Changing API access
You can manage the API access for applications that have previously been allowed or
denied.

To change API access

1. Click Preference on the Softphone menu (Windows) or the Bria Enterprise menu
on the menu bar (Mac).

2. Click Security on the Application tab.

3. Click an application and use the arrows to move it between Allowed Applications
and Denied Applications.
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4. Click OK.

The access has been changed for the application.

Contact list headings
Following is a list of heading that are used in the Bria Enterprise contact list. This list can
be useful when formatting a contact list to import into Bria Enterprise.

Heading Description

business_number

business_numbern, where n is 2 to 6

categories Maps to Bria Enterprise groups

default_address Maps to the Presence field

default_address_com Always specifies IM, if default is specified

Does not map to a Contact Profile field

default_address_type Specifies SIP or XMPP

display-name

email_address

email_addressn, where n is 2 to 6

fax_number

Fax_numbern, where n is 2 to 6

given_name

home_number

home_numbern, where n is 2 to 6

mobile_number
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Heading Description

mobile_numbern, where n is 2 to 6

other_address

other_addressn, where n is 2 to 6

postal_address

presence_subscription TRUE or FALSE

sip_address Maps to the Softphone field

sip_addressn, where n is 2 to 6

surname

web_page

web_pagen, where n is 2 to 6

xmpp_address Maps to the Instant Message field

Must always specify an XMPP address

xmpp_addressn, where n is 2 to 6 Maps to the Instant Message field

Must always specify an XMPP address

Location of files
Application files are installed and saved in your computer.

Windows
System files get copied to the installation directory specified when you install Bria
Enterprise. The default installation directory is:

C:\Program Files (x86)\CounterPath\Bria Enterprise

Data files are saved in the CounterPath folders in the standard location for application
data, as defined in Windows. The locations are typically:

C:\Users\<user name>\AppData\Roaming\CounterPath Corporation\Bria Enterprise

C:\Users\<user name>\AppData\Roaming\CounterPath\

License keys are saved in Program Data.

C:\ProgramData\CounterPath Corporation\Bria Enterprise
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Mac
Files get copied to Applications, Preferences, and Application Support when you install
Bria Enterprise.

~/Applications

~/Library/Preferences/com.CounterPath_Corporation.Bria-Enterprise.plist

~/Library/Application Support/CounterPath Corporation/Bria Enterprise/6.0
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